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LỜI NÓI ĐẦU 

 Ngành sản xuất bao bì Việt Nam đang ngày càng phát 

triển, các trang thiết bị, công nghệ ngành In và bao bì đang được 

các doanh nghiệp quan tâm và đầu tư. Tuy nhiên, nguồn nhân lực 

được đào tạo chuyên môn về lĩnh vực này đang là vấn đền lớn với 

các doanh nghiệp. Thấu hiểu được thị trường, Khoa In và truyền 

thông đã đưa vào chương trình đào tạo kỹ sư công nghệ in những 

môn học liên quan đến sản xuất bao bì, trong đó có môn “Thực 

tập thiết kế cấu trúc bao bì và định hình hộp”. Môn học này giúp 

sinh viên có được những kiến thức cơ bản về các cấu trúc hộp, 

cách gấp, dựng hộp cơ bản, cách xác định mối liên hệ giữa các 

cạnh trong cấu trúc hộp...song song đó là việc sử dụng phần mềm 

ArtioCAD, một phần mềm thiết kế cấu trúc bao bì chuyên dụng. 

Giáo trình này được thiết kế phục vụ cho môn học “Thực tập 

thiết kế cấu trúc bao bì và định hình hộp”, đây là một tài liệu 

hướng dẫn cụ thể giúp sinh viên tiếp cận phần mềm một cách 

nhanh chóng. Cấu trúc tài liệu được chia thành 7 bài với các nội 

dung chính như sau: 

BÀI 1: TỔNG QUAN VỀ PHẦN MỀM ARTIOSCAD 7X.  

Bài học giúp sinh viên có cái nhìn tổng quát về giao diện làm việc 

của phần mềm, các chức năng, cách sử dụng công cụ trong phần 

mềm, lưu trữ, truy suất file... 

Bài 2: TẠO MẪU CẤU TRÚC BAO BÌ HỘP BẰNG CÔNG 

CỤ RUN A STANDARD. Bài học hướng dẫn các bước để có thể 

sử dụng được những mẫu hộp có sẵn trong thư viện mẫu – style 

catalogue, và các hình học đặc biệt như các lỗ treo – hanger trong 

thư viện Geometry Macro, các công cụ hiển thị kích thước, chú 

thích. 

BÀI 3: TẠO KHỔ TRẢI CỦA CẤU TRÚC BAO BÌ HỘP 

VỚI CÁC CÔNG CỤ THIẾT KẾ GEOMETRY – CONLINE. 

Bài học giúp sinh viên có thể sử dụng các công cụ vẽ để thể hiện 

lại mẫu cấu trúc bất kỳ 
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BÀI 4: CHỈNH SỬA MẪU CẤU TRÚC BAO BÌ HỘP VỚI 

NHÓM CÔNG CỤ EDIT, ADJUST. Bài học hướng dẫn sinh 

viên sử dụng công cụ chỉnh sửa để điều chỉnh lại mẫu thiết kế cấu 

trúc, sao chép các chi tiết, đặc biệt ứng dụng công cụ sao chép 

nhiều lần và sao chép xoay để tạo các dạng hộp đa cạnh, đa giác.  

BÀI 5: CHUYỂN ĐỔI CẤU TRÚC HỘP TỪ KHỔ TRẢI 2D 

SANG DẠNG 3D. Sinh viên có thể chuyển đổi, gấp dựng hộp đã 

thiết kế từ dạng 2D sang dạng 3D sau khi học xong bài học này. 

Sinh viên còn học được cách kiểm tra cấu trúc, các chế độ xem 

khác nhau để tìm ra lỗi... 

BÀI 6: ĐẶT THIẾT KẾ ĐỒ HỌA VÀO MẪU CẤU TRÚC 

HỘP. Bài học được thiết kế giúp sinh viên có thể áp các hình đồ 

họa vào cấu trúc hộp theo các tùy chọn phù hợp, tạo được các 

vùng tô màu, cắt xén hình ảnh, tạo được các hình dạng đặc biệt 

tương ứng với hình dạng đồ họa. 

BÀI 7: TẠO THƯ VIỆN MẪU HỘP VỚI CÔNG CỤ 

STYLEMAKER. Chức năng cao nhất trong phần design của 

phần mềm ArtiosCAD là cho phép người dùng tạo được các file 

thiết kế có thể thay đổi được kích thước, người dùng có thể tạo 

riêng cho mình một thư viện mẫu hộp để sử dụng. Bài học này sẽ 

giúp sinh viên thực hiện được thư viện cho riêng mình. 

 

 

 



BÀI 1: TỔNG QUAN VỀ PHẦN MỀM 

ARTIOSCAD 7X 

 

Mục tiêu bài học: 

Sau khi học xong bài học này sinh viên có khả năng: 

- Hiểu được các tính năng, nguyên tắc hoạt động của giao diện 

làm việc của phần mềm ArtiosCAD. 

- Thực hiện được các thao tác cơ bản với phần mềm như: Mở 

trang mới, lưu file vào hệ thống, thiết lập các thông số mặc 

định, thay đổi đơn vị, hướng sớ giấy, mặt thiết kế trong phần 

mềm, xuất được file thiết kế sang các định dạng khác… 

- Sử dụng được các chế độ view khác nhau để kiểm tra mẫu thiết 

kế. 

- Hiểu được chức năng chính của các nhóm công cụ trong 

toolbar, layer. 

 

1. GIAO DIỆN LÀM VIỆC CỦA PHẦN MỀM 

ARTIOSCAD 7X. 

 Phần mềm ArtiosCAD là phần mềm hổ trợ trong thiết kế cấu 

trúc cho các loại bao bì giấy, bao bì carton dợn sóng. Phần mềm giúp 

người thiết kế cấu trúc số hóa mẫu thiết kế phác thảo. Ngoài ra phần 

mềm còn kết nối được với phần mềm thiết kế đồ họa như AI (Adobe 

Ilusstrator) định dạng được các đường cấn bế trong AI, xuất được các 

file PDF,EPS…hoặc liên kết với các thiết bị sản xuất như: cắt mẫu 

hộp, cưa khuôn bế, cắt dao cấn và bế… Chúng ta sẽ cùng tìm hiểu các 

giao diện, chức năng của các nhóm công cụ hổ trợ thiết kế cấu trúc. 

 Để bắt đầu công việc với phần mềm ArtiosCAD, chúng ta khởi 

động phần mềm bằng cách douple click vào icon của phần mềm  

hoặc Start > Programs > ArtiosCAD > ArtiosCAD 7.xx. 
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Giao diện thiết kế của phần mềm ArtiosCAD 7.x 

Giao diện này gồm 4 vùng: 

 Thanh menu chính và các biểu tượng shortcut 

 

 Vùng hiển thị các công cụ thiết kế, chỉnh sửa, chú 

thích…của phần mềm. 

 Thanh Status hiển thị các option của công cụ được chọn, 

những gợi ý, hướng dẫn thao tác khi chọn công cụ đó và 

nhập các giá trị cho công cụ khi thiết kế. 

 

 
 

1 

2 

3 

4 

N ơi nh ập gi á tr ị 
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Giá trị có thể được nhập trực tiếp vào ô trống hoặc có thể click vào 

biểu tượng bàn tính  và nhập giá trị. Khi nhấp vào biểu tượng thì 

hộp thoại bên dưới sẽ xuất hiện. 

 

 Vùng thiết kế: mẫu thiết kế sẽ được hiển thị trong vùng 

này. 

1.1. Thanh menu chính.  

Cũng giống như các phần mềm khác, thanh menu chính chứa toàn bộ 

những lệnh có trong phần mềm. Trong menu File có những chức năng 

sau: 

New design (Ctrl +N): Tạo trang thiết kế mới ở giao diện Thiết kế. 

Run a standard (Ctrl + 2): Tạo mẫu thiết kế dựa trên những mẫu có 

sẵn trong thư viện mẫu. 

New 3D (Ctrl + 3): Tạo trang mới ở giao diện 3D. 

Convert to 3D: chuyển mẫu thiết kế sang 3D. 

New Manufacturing: Tạo trang mới ở giao diện Manufacturing. 

Convert to Manufacturing: Chuyển mẫu thiết kế sang giao diện 

Manufacturing để bình mẫu thiết kế và tạo khuôn bế. 

Standard Sheet Layout: Chuyển mẫu thiết kế sang giao diện 

Manufacturing để bình, tuy nhiên mẫu thiết kế sẽ tự động bình theo 

các kiểu bình và các khổ giấy có sẵn trong phần mềm. 

New Counter Layout: Tạo trang mới ở giao diện Manufacturing.  
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Open (Ctrl + O): Mở các file thiết kế đã được lưu. 

Open Project: Mở các mẫu thiết kế có nhiều file nằm trong một nhóm 

thiết kế. 

Open URL: Mở các file từ trên website. 

Search: Tìm những mẫu thiết kế có những đặc điểm đặc biệt. 

Close: Đóng file thiết kế đang vẽ. 

Close All: Đóng tất cả các file thiết kế. 

 

Import File (Ctrl + I): Nhập file từ bên ngoài. 

Outputs: xuất file thiết kế ra các thiết bị sản xuất, làm mẫu. 

Export: Xuất file thiết kế cấu trúc sang các định dạng khác nhau như: 

EPS (phần mềm AI), DXF (phần mềm AutoCAD), CFF2 (phần mềm 

bình trang điện tử), PDS, và các version của ArtiosCAD… 
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Save (Ctrl+S), Save As, Save Copy As: Lưu file thiết kế. 

Delete: Xóa file thiết kế. 

 

Exit: thoát khỏi phần mềm 

 

Chức năng Edit trên thanh menu chính chứa các lệnh và công cụ chỉnh 

sửa như: chọn đối tượng (select), copy, quay đối tượng.. 
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Chức năng View trên thanh menu chính chứa các công cụ dùng để 

xem mẫu thiết kế như: phóng ta, thu nhỏ, chế độ xem (view mode)… 

 

 Zoom rectangle/ Zoom in (Ctrl+R): Phóng to mẫu thiết kế ở vùng 

được chọn. 

 Zoom out (Ctrl + A): Thu nhỏ mẫu thiết kế ở vùng được chọn. 

 Pan: Dịch chuyển vùng xem của mẫu thiết kế. 

 Scale to fit (Ctrl + D): Thu nhỏ mẫu thiết kế nằm gọn trong cửa 

sổ hiển thị. 
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 Scale to fit with board: Thu nhỏ đối tượng theo một tỷ lệ nhất 

định, thường được mặc định là 25%.  

 

Để thiết lập lại tỷ lệ vào Options>Defaults>Startup defaults>View 

tool options. 

 

Close up (Ctrl +Space): chức năng này tương tự như một kính lúp, 

phóng to vùng chi tiết muốn quan sát. 
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 View mode: Chức năng mày giúp quan sát, kiểm tra mẫu thiết kế 

theo từng đặc tính riêng biệt. Khi click vào biểu tượng này, hộp thoại 

bên dưới sẽ xuất hiện. 

 

Chức năng Tools trên thanh menu chính chứa tất cả các công cụ để tạo 

mẫu thiết kế như: tạo hình, chỉnh sửa hình, hiển thị kích thước, áp 

hình ảnh đồ họa… 
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1.2 Các biểu tượng shortcut 

View Bar chứa các shortcut thường dùng như:  

 Open: Mở file.  Save: lưu file. 

 Rebuild: thiết lập lại thông số cho mẫu thiết kế có trong thư viện. 

 Manufacturing: chuyển mẫu thiết kế sang giao diện 

manufacturing để bình. 

 Convert to 3D: chuyển mẫu thiết kế qua 3D. 

 Layer 

 Định dạng thuộc tính đường của mẫu thiết kế. 

 Định dạng độ dày dao cấn và dao bế.  
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 Hướng sớ giấy hoặc hướng sóng của mẫu thiết kế. 

 Định nghĩa mặt trong (mặt không in) hoặc mặt ngoài (mặt in) của 

mẫu thiết kế,  Đơn vị của mẫu thiết kế. Khi click vào các biểu 

tượng này  hướng sớ giấy, mặt in và đơn vị sẽ đổi chiều và  

đơn vị (từ Inch sang mm). 

Ngoài ra trên thanh View Bar còn có hai shortcut của tool bar là:  

ArtiosCAD Toolbars dialog  chứa tất cả các công cụ hổ trợ thiết 

kế của phần mềm, chỉ cần click vào biểu tượng của công cụ để mở 

hoặc tắt công cụ hoặc có thể click All on hoặc All off để mở hoặc tắt 

tất cả các công cụ.  

 

Customized Toolbars dialog  chứa những công cụ thiết kế đã được 

chọn.  
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Tạo Customized toolbars: default < customized toolbars  < Design 

customized toolbars  < Click phải chuột < chọn new < data < đặt tên 

cho data mới <  double click vào tên vừa tạo < chọn công cụ < 

chuyển công cụ từ Tools in the ArtiosCAD Toolbar sang Tools in the 

Custom Toolbar < click OK < Save defaut.  

 

Để lưu lại vị trí của các công cụ View < Save Toolbar configuration, 

để phục hồi lại vị trí đã được lưu trước đó View < Restore Toolbar 

configuration. 
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2. CHỨC NĂNG CỦA CÁC NHÓM CÔNG CỤ 

TRONG TOOLBAR. 

 Zoom: Nhóm công cụ dùng để phóng to, thu nhỏ và các chế độ 

xem khác nhau.  

 Geometry: Nhóm công cụ dùng để tạo hình cho mẫu thiết kế 

 Dimension: Nhóm công cụ dùng để đo và thể hiện kích thước của 

mẫu thiết kế. 

 Adjust: Nhóm công cụ dùng để hiệu chỉnh các đường hình học đã 

được vẽ như độ dài, góc xoay... 

 Conline: Nhóm công cụ dùng để tạo các đường gióng khi vẽ, 

những đường này không được xuất, in…như các đường hình học khác. 

 Edit: Nhóm công cụ dùng để hiệu chỉnh vị trí của các đường hình 

học như: di chuyển, copy, xoay.. 

 Annotation: Nhóm công cụ dùng để chú thích các chi tiết của mẫu 

thiết kế. 

 Undo – redo: Nhóm công cụ undo hoặc redo. 

 Adjust Outline: Nhóm công cụ dùng để điều chỉnh các đường hình 

học thành các đường thẳng theo chiều ngang, dọc, đường thẳng thành 

đường tròn hoặc ngược lại… 

 Extend/Measure: Nhóm công cụ dùng để mở rộng đường gióng 

của các đường thẳng, tròn, cung tròn… 

 Graphics: Nhóm công cụ dùng để add hình ảnh đồ họa, chỉnh sửa 

các hình đồ họa. 

 Report: Nhóm công cụ dùng để lập các báo cáo. 

 Counter: Nhóm công cụ dùng để tạo chỉ bế. 

 Registration Holes: Nhóm công cụ dùng để tạo các vị trí định vị 

trên khuôn bế. 
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3. LAYER. 

Tương tự như một số phần mềm thiết kế đồ họa, ArtiosCAd quản lý 

mẫu thiết kế theo các lớp (layers). 

Layer Main design: tập hợp những đường hình học tạo nên mẫu thiết 

kế, kể cả các đường gióng (conline), những đường vẽ trên layer này sẽ 

được xuất ra thiết bị hoặc xuất ra các định dạng file khác. 

Layer Overall dimension: hiển thị các đường kích thước của mẫu thiết 

kế như: dài, rộng, cao, góc bo, góc nghiêng...  

  

Biểu tượng con mắt là để xem các chi tiết trên các layer. 

Biểu tượng ổ khóa dùng để khóa các layer, khi layer bị khóa thì trên 

vùng thiết kế sẽ xuất hiện , các công cụ sẽ không sử dụng được. 

Khi muốn chọn một layer mới click nút Create.., Khi muốn xóa layer 

click nút Properties < chọn layer < delete. 
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4. BÀI TẬP ỨNG DỤNG. 

Bài 1: Tạo Customized toolbars gồm các công cụ như hình bên dưới, 

lưu data bằng tên Move. 

  

Bài 2: Mở file 4A.ard. Sử dụng những công cụ khác nhau của View 

để tìm 5 vị trí lỗi trong mẫu thiết kế này. Liệt kê các lỗi của mẫu thiết 

kế. 

 

Bài 3: Mở file 4C.ARD,  Sử dụng View mode kết hợp với các công cụ 

của View để tìm ra 7 vị trí lỗi của mẫu thiết kế, liệt kê các lỗi. Liệt kê 

số lượng cung tròn sử dụng mẫu thiết kế này. 
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Bài 4: Mở file 4D.ard xuất file 1 thành file PDF. File 2, file 3 thành 

file EPS như sau: 

File 1 

79 .5 10 0 80 10 0

53

15 0

79 .5

23

30 5 .5

13

40

51 .2 5

5. 5

3

10 .5

 

File 2 

13

40

51 .2 5

5. 5

3

10 .5

 

File 3 
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Bài 2: TẠO MẪU CẤU TRÚC BAO BÌ HỘP 

BẰNG CÔNG CỤ RUN A STANDARD 

  

Mục tiêu bài học: 

Sau bài học này sinh viên có khả năng: 

- Hiểu được đặc điểm cấu trúc của một số hộp cơ bản dạng hình 

chữ nhật, khay… 

- Hiểu được những thông số chính của vật liệu và lựa chọn được 

vật liệu phù hợp với mẫu cấu trúc. 

- Thiết lập được bản vẽ khổ trải của các hộp cơ bản bằng công 

cụ Run a Standard. 

- Thiết lập được bản vẽ khổ trải của các hộp cơ bản bằng công 

cụ Geometry Macro. 

- Nhận biết và xử lý được các trường hợp giá trị biến số không 

phù hợp. 

- Trình bày được các hiển thị kích thước, mô tả của mẫu cấu trúc 

bằng các công cụ trong nhóm Dimension và Annotation. 

 

1. THIẾT LẬP BẢN VẼ KHỔ TRẢI CỦA MẪU CẤU 

TRÚC BAO BÌ HỘP VỚI CÔNG CỤ RUN A 

STANDARD.  

Run A Standard là một chức năng của phần mềm cho phép sử 

dụng lại các mẫu thiết kế có sẵn trong thư viện bằng cách thay đổi các 

giá trị kích thước. Để sử dụng các mẫu bao bì hộp trong thư viện, 

chúng ta cần thực hiện các bước sau: 

Bước 1: Lựa chọn mẫu cấu trúc hộp 

Chọn file < run a standard < chọn mẫu hộp có sẵn trong thư viện. 

Hoặc sử dụng phím tắt (ctrl + 2) để mở hộp thoại Run a standard.  

Có 2 cách để chọn mẫu hộp: 
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 Nhập trực tiếp mã số của hộp vào ô wordspace  

 Chọn mẫu hộp trong các cây thư mục. 

   

Bước 2: Lựa chọn loại giấy (the board)  

Sau khi lựa chọn mẫu cấu trúc hộp, một hộp thoại vật liệu (Board) 

sẽ xuất hiện, chúng ta sẽ lựa chọn vật liệu phù hợp với mẫu cấu trúc 

đó. Các loại vật liệu trong Board bao gồm: 

 Corrugated: là nhóm carton dợn sóng với các loại sóng 3 lớp (E, 

B, C), 5 lớp (BC), 7 lớp (BCB), 9 lớp (BCCB)…với các loại vật 

liệu sóng khác nhau như: giấy, nhựa… 

 Folding carton: là nhóm vật liệu giấy thông dụng trong bao bì hộp 

giấy, túi giấy như giấy tráng phấn, giấy Kraft… 
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 Mỗi loại vật liệu sẽ có thông số kỹ thuật được hiển thị ở board 

properties, bao gồm các thông số sau:  

Caliper (CAL): hiển thị giá trị độ dày giấy được chọn. 

Inside Loss (IL): giá trị bị mất khi thực hiện đường cấn, bên trong. 

Outside Gain (OG): giá trị bị mất khi thực hiện đường cấn, bên ngoài. 

 

Bước 3: Thiết lập kích thước cho mẫu cấu trúc hộp 

Nhập các thông số kích thước dài (L), rộng (W), cao (D) của mẫu 

hộp trong tab “Inside dimension”  

 

Nhấn Next để sang bước tiếp theo nếu cần chỉnh sửa lại các thông 

số liên quan. Nhấn Previous để quay trở về bước trước. 
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Khi nhập giá trị biến số cần quan sát hình vẽ chú thích bên cạnh 

để biết được vị trí của biến. 

Nhấn OK, nếu chấp nhận các thông số mặc định, khi đó màn hình sẽ 

hiển thị vùng làm việc với mẫu hộp đã chọn. 

 

2. NHỮNG GIÁ TRỊ BIẾN SỐ KHÔNG THỎA ĐIỀU 

KIỆN. 

Trong quá trình thiết lập giá trị biến số, chúng ta sẽ gặp trường 

hợp biến số không thỏa điều kiện ràng buộc.  

 

Chúng ta có thể nhận biết giá trị không thỏa qua hai dấu hiệu sau:  

 Giá trị của biến được thiết lập lần trước và hiện tại đều 

không phù hợp với giá trị mặc định. 
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 Giá trị của biến được thiết lập lần trước phù hợp với giá trị 

mặc định, nhưng hiện tại thì không. 

 

Những giá trị này chỉ cảnh báo cho người sử dụng biết về giá trị 

nhập, có thể bỏ qua các cách báo này bằng cách chọn Ignore.  

Tuy nhiên, một số biến sẽ được ràng buộc bằng những điều kiện. 

Khi các giá trị nhập vào không thỏa các điều kiện thì phần mềm sẽ 

hiển thị hộp thoại Check Condition Conflicts. 

 

Hộp thoại này sẽ báo tên biến, giá trị hiện tại, những điều kiện ràng 

buộc, mô tả biến của mẫu cấu trúc, chúng ta có thể dựa vào đó để thay 

đổi thông số cho phù hợp. 
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3. THIẾT LẬP BẢN VẼ KHỔ TRẢI CỦA MẪU CẤU 

TRÚC BAO BÌ HỘP VỚI CÔNG CỤ GEOMETRY 

MACROS. 

Nếu như Run a standard tạo một mẫu cấu trúc hộp hoàn chỉnh thì 

Geometry Macros chỉ tạo từng phần của mẫu hộp như: thân hộp, nắp 

hộp, đáy hộp hoặc những chi tiết hình học thường sử dụng trong các 

mẫu hộp như các lổ treo (Hanger), các công cụ sản xuất khuôn bế 

(Manufacturing Tools)…Việc thiết lập bản vẽ của mẫu cấu trúc hộp 

được thực hiện qua các bước sau: 

Bước 1: Mở hộp thoại Geometry Macros. chọn Tool < Geometry 

macro 

 

Bước 2: Chọn mẫu chi tiết muốn sử dụng trong Geometry macros 

catalog.  
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 Folding carton tools: là những chi tiết từng phần của mẫu hộp. 

Chúng ta có thể kết hợp cácphần khác nhau để tạo ra một mẫu thiết kế 

đặt biệt mà vẫn đảm bảo những tính năng sử dụng. 

 Hangers: là những chi tiết dùng để tạo lỗ trên mẫu thiết kế với 

mục đích treo. 

Bước 3:  Nhập giá trị của các biến cho chi tiết. 

Bước 4: Chọn vị trí để đặt chi tiết. Sau khi nhập giá trị biến số, chi tiết 

sẽ hiển thị trong vùng thiết kế, để chọn vị trí đặt chi tiết click chọn các 

biểu tượng ở thanh Status. 

 

Nếu muốn tạo nhiều chi tiết giống nhau, click chọn vào ô Repeat 

Placement. 

 Đặt chi tiết tại một điểm.  

 Đặt chi tiết ở vị trí bất kỳ. 

Đặt chi tiết ở vị trí cách 2 đường vuông góc bất kỳ một khoảng. 

 Đặt chi tiết ở vị trí cách đường thẳng bất kỳ một khoảng. 
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 Đặt chi tiết ở vị trí bất kỳ trên một đường thẳng. 

 Đặt chi tiết ở vị trí giữa của đường thẳng, xoay quanh một vị trí 

bất kỳ được chọn. 

 Đặt chi tiết ở vị trí trên một đường đặt biệt được nối bởi 2 điểm. 

 

4. THAY ĐỔI THÔNG SỐ KỸ THUẬT CHO MẪU 

CẤU TRÚC HỘP ĐÃ THIẾT LẬP 

Để thay đổi kích thước của mẫu hộp, độ dày giấy hoặc kiểu dáng 

hộp đã thiết lập trước đó, chúng ta sử dụng công cụ Rebuild .  

4.1. Thay đổi kích thước của cấu trúc hộp. 

Việc thay đổi kích thước mẫu hộp được thực hiện qua các bước 

sau: 

Bước 1: Mở hộp thoại Rebuild. Có 3 cách để mở hộp thoại Rebuild:  

 Vào Design < Rebuild design. 

 Nhấn phím tắt F5. 

 Nhấn shortcut  trên thanh menu. 

 

Bước 2: Nhập giá trị của biến số cần thay đổi. 



25 

 

Nếu chỉ muốn chỉnh sửa một vài phần cần thiết thì có thể nhấn tam 

giác nhỏ , một danh sách tên các thành phần sẽ được hiển thị, chọn 

phần Menu muốn chỉnh sửa. 

 

Chức năng Reinit: Sử dụng lại giá trị mặc định của biến số đạng 

chọn.Chức năng Reinit All: Sử dụng lại giá trị mặc định của tất cả các 

biến có trong menu đang chọn. 

 

Chức năng Edit: cho phép chỉnh lại các thông số  của biến số đang 

được chọn. 

Chức năng Reset: Khôi phục lại giá trị của biến được thiết lập ở lần 

trước.  

4.2. Thay đổi kiểu dáng, vật liệu cho cấu trúc hộp. 

4.2.1 Thay đổi vật liệu 

Chức năng này cho phép xây dựng lại kiểu dáng khác cho mẫu thiết 

kế với cùng kích thước đã thiết lập ban đầu.  

Bước 1: Mở chức năng Rebuil. 
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Bước 2: Chọn Board selection để thay đổi loại vật liệu phù hợp. Có 2 

cách để thực hiện: Ở menu Inside Dimensions, (nơi thể hiện các kích 

thước chiều dài (L), rộng (W), cao (D) của mẫu hộp), nhấn Previous 

để quay trở lại hộp thoại Board selection, hoặc mở list menu chọn 

Board selection.  

 

Bước 3: Chọn lại loại giấy tương ứng, nhấn OK để thiết lập loại vật 

liệu mới.  

4.2.2 Thay đổi kiểu dáng 

Nếu muốn thay đổi kiểu dáng, ở hộp thoại Board selection chúng ta 

chọn tab Run New Standard, chúng ta có thể lựa chọn mẫu cấu trúc 

mới với phần kích thước chiều dài (L) x chiều rộng (W) x chiều cao 

(D) như ban đầu, giá trị của các biến số có thể thay đổi theo nhu cầu. 
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5. HIỂN THỊ KÍCH THƯỚC, CHÚ THÍCH CHO MẪU 

CẤU TRÚC (ANNOTATION VÀ DIMENSIONS) 

Công cụ Dimension và Annotaion là công cụ hổ trợ hiển thị kích 

thước và các chú thích cho các mẫu thiết kế.  

5.1 Hiển thị kích thước với công cụ dimensions 

Để chọn các công cụ Dimensions vào tool < dimension < chọn công 

cụ muốn sử dụng. Hoặc mở nhóm công cụ dimension trong toolbar.  

 

Temporary Dimension: Hiển thị kích thước tạm thời, những hiển thị 

này không được in, khi sử dụng công cụ này thì không cần tạo Layer 

Dimension. 

Distance: công cụ đo các khoảng cách. 

Angle: công cụ đo góc của hai đường thẳng bất kỳ. 

Angle to horizontal: công cụ đo góc của đường thẳng bất kỳ với một 

đường ngang (song song trục X). 

Angle to Vertical: công cụ đo góc của đường thẳng bất kỳ với một 

đường đứng (song song trục Y). 

Radius: công cụ đo bán kích của các cung tròn, đường tròn. 
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Radius to Circle: công cụ đo bán kính đường tròn. 

Diameter: công cụ đo đường kính của các cung tròn, đường tròn. 

Diameter: Công cụ đo đường kính của các đường tròn. 

Auto Aligned Distance Dimension: Công cụ hiển thị và xếp thẳng 

hàng các kích thước theo chiều ngang, dọc. 

Auto dimension: Công cụ tự động hiển thị các kích thước của tất cả 

các chi tiết của mẫu thiết kế. 

Auto dimension window: Công cụ tự động hiển thị kích thước trong 

vùng được chọn.   

5.2. Hiển thị chú thích với công cụ Annotation. 

 

Text: Công cụ dùng để nhập các ghi chú bằng text. 

Align Text Left: Công cụ dùng để sắp xếp các text thẳng hàng về bên 

trái. 

Align Text Horizontal Center: Công cụ dùng để sắp xếp các text 

thẳng hàng ở giữa theo trục đứng. 

Align Text Vertical Center: Công cụ dùng để sắp xếp các text thẳng 

hàng ở giữa theo trục ngang. 

Align Text Right: Công cụ dùng để sắp xếp các text thẳng hàng về 

bên phải. 
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Align Text Bottom: Công cụ dùng để sắp xếp các text thẳng hàng về 

phía dưới. 

Align Text Top: Công cụ dùng để sắp xếp các text thẳng hàng về phía 

trên. 

Arrow: Công cụ dùng để tạo các mũi tên chỉ dẫn. 

Detail: Công cụ dùng để tạo hình ảnh phóng to của các chi tiết. 

 

Adjust Detail: Công cụ dùng để chỉnh các hình ảnh phóng to của các 

chi tiết. 

 

 Move Clip: di chuyển vùng chi tiết muốn phóng to. 

 Move Detail: di chuyển các hình ảnh phóng to. 

 Move Side: di chuyển cả vùng chi tiết và hình ảnh phóng 

to. 

Outline Text: Chuyển text thành các đường bao bên ngoài text. Chúng 

ta có thể định dạng các đường này thành đường cắt, cấn… 

 

Line text: chuyển text thành đường thẳng.  

 

Detail 

Clip 



30 

 

Các đường Outline và line text đều có thể định nghĩa thành các đường 

cắt, cấn, đường in, đường hiển thị… 

 

6. BÀI TẬP ỨNG DỤNG.  

Bài 1: Tạo mẫu hộp carton sóng mã F0201W, loại giấy: sóng C, M-

32/200C. Khổ thành phẩm: 250x230x150 cm. Lưu file dưới tên: 

F0201W C/M32 200 

 

Bài 2: Tạo mẫu hộp có kiểu dáng như hình bên dưới, loại giấy:  M- 

SBS 250. Khổ thành phẩm: 80x50x150 cm. Lưu file dưới tên 

141.11/MSBS 250. 

 

Bài 3: Thay đổi khổ thành phẩm và loại giấy của file 141.11/MSBS 

250. Khổ TP: 75.5x50x120cm, loại giấy: M- SBS 300. Lưu file dưới 

tên 141.11/MSBS 300/75.5x50x120. 
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Bài 4: Thay đổi dạng dáy của file 141.11/MSBS 250 theo hình bên 

dưới. Lưu file dưới tên 141.11N/MSBS 300/75.5x50x120. 

 

Bài 5: Sử dụng chức năng Run a Standard để thay đổi khổ kiểu dáng 

của file 141.11/MSBS 300/75.5x50x120 giống như hình bên dưới, 

kích thước và loại giấy vẫn giữ nguyên. Lưu file dưới tên 152.04.A 

MSBS 300/75.5x50x120. 

 

Bài 6: Mở file 14C, sử dụng Hanger 1 trong Geometry Macro catalog 

để tạo phần treo (hanger) cho mẫu thiết kế như hình bên ưới. Giá trị 

của Hanger: 

 L= 25mm, H=5mm, W=5mm, CR=5mm, BR=1mm 

 



32 

 

Bài 7: Sử dụng công cụ Geometry Macros. Mở file 14B.ard, chọn chi 

tiết handhold trong Utilities để tạo thiết kế như hình bên dưới. Giá trị 

của handhold:  

 W=75 mm, H=25 mm  

 

Bài 8: Sử dụng công cụ Geometry Macros chọn các chi tiết trong thư 

mục Folding carton để tạo mẫu thiết kế như bên dưới. Khổ TP: 

100x50x200. 

 

Bài 9: Mở file 5A.ard, sử dụng các công cụ Dimension để hiển thị 

kích thước cho hộp bên dưới trên layer Dimension. 
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BÀI 3: TẠO KHỔ TRẢI CỦA CẤU TRÚC BAO 

BÌ HỘP VỚI CÁC CÔNG CỤ THIẾT KẾ 

GEOMETRY – CONLINE . 

 

Mục tiêu bài học: 

Sau bài học này người học có khả năng: 

- Hiểu được các tính năng của nhóm công cụ Geometry, Conline. 

- Tạo được khổ trải của cấu trúc bao bì hộp dạng cơ bản như: 

nắp cài, nắp dán, đáy cài khóa, đáy dán, thân lục giác, thân 

hình chữ nhật, khay chữ nhật, khay 4 góc, 6 góc…bằng công 

cụ Geometry, Coline. 

1. QUY TRÌNH THỰC HIỆN TẠO MẪU CẤU TRÚC 

BẰNG NHÓM CÔNG CỤ GEOMETRY, CONLINE. 

Để vẽ lại các mẫu cấu trúc hộp cần thực hiện theo các bước sau:   

Bước 1: Lập kích thước cho mẫu hộp muốn vẽ lại. 

Bước 2: Tạo trang thiết kế mới. Vào File < New design. Hoặc sử dụng 

phím tắt Ctrl + N. 

Bước 3: Chọn loại giấy cho mẫu hộp.  

 

Bước 4: Vẽ lại các mẫu hộp với các công cụ hổ trợ thiết kế. 

Bước 5: Định dạng đường cho mẫu thiết kế. 

Bước 6: Lưu mẫu hộp.  
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2. TÍNH NĂNG CỦA NHÓM CÔNG CỤ HỔ TRỢ 

THIẾT KẾ.  

2.1. Current point. 

Move point là nhóm công cụ dùng để chọn điểm bắt đầu vẽ. 

Trước khi vẽ bất cứ chi tiết nào cũng cần phải chọn điểm bắt 

đầu.Trong nhóm move point có 02 công cụ: Move to point và 

Move by. 

 Move to point (Ctrl + W): Di chuyển điểm bắt đầu vẽ đến 

những vị trí giao nhau giữa các đường, hoặc các điểm nút trên 

một đường. Nếu sử dụng công cụ này, không thể chọn vẽ ở điểm 

bất kỳ. 

Move by (Ctrl + Q): Di chuyển điểm bắt đầu vẽ đến những điểm 

có thể xác định giá trị. 

2.2 Selection Tools. 

Selection tool là nhóm công cụ chọn đối tượng. Công cụ chọn luôn 

được hiển thị ở thanh Status.  

 

 Normal selection: chọn từng đường nếu đường không được 

group, nhóm đối tượng (group). 

 Selection ignoring groups: chọn từng đường trong nhóm đối 

tượng. 

 Selection of connected lines across intersections: chọn tất cả 

các đường nối qua đi qua giao điểm 
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 Selection of connected lines stopping at intersections: Chọn tất 

cả các đường nối cắt nhau tại giao điểm. 

Bốn công cụ trên dùng để phân loại cách chọn đối tượng. 

 Select only design lines (text and dimensions): Chọn các chi tiết 

có trong file thiết kế như: các đường thiết kế, text, đường chú thích, 

hình ảnh…nhưng không chọn được các đường gióng (conline). 

 Select design and construction lines: Ngoài các đường có trong 

thiết kế, công cụ còn chọn được các đường gióng (conline). 

 Select only construction lines: Chỉ chọn các đường gióng 

(conline). 

 Select only text items: Chỉ chọn được các chi tiết dạng text. 

 Select only dimensions: Chỉ chọn các đường kích thước. 

 Select only graphic items: Chỉ chọn các hình ảnh. 

Sáu công cụ này dùng để phân loại đối tượng chọn. 

 Select items crossing: Công cụ cho phép chọn đối tượng bằng 

cách quét vùng chọn (vùng chọn là hình chữ nhật hoặc hình vuông). 

Đối tượng nào được quét qua thì sẽ được chọn. 

 Select items inside: Công cụ cho phép chọn đối tượng nằm trọn 

trong vùng chọn (vùng chọn là hình chữ nhật hoặc hình vuông). 

 Select Polygon: Công cụ cho phép chọn các đối tượng bằng cách 

đi đường dẫn (path), những đối tượng nào nằm trọn trong vùng chọn 

(có hình dạng bất kỳ) sẽ được chọn. 

 Select All: Chọn toàn bộ mẫu hộp. 

Bốn công cụ trên dùng để phân loại vùng chọn. 

Ứng dụng: Mở file SELECT.ard để thực nghiệm 04 công cụ phân loại 

cách chọn. 
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Mở tất cả các layer của file, thử nghiệm các công cụ chọn lựa có trên 

thanh Status. 

2.3. Line Tools. 

Line tool là nhóm công cụ tạo đường thẳng. Để mở các công cụ 

line tool, chọn trên thanh menu chính Tool <Geometry<Line 

Angle/Offset hoặc Line Angle/Length hoặc Line Horizontal/Vertical. 

 

  Line Angle/Offset: tạo đường thẳng với giá trị của góc và khoảng 

cách (hình chiếu của đường thẳng) theo chiều X hoặc Y. 

  Line Angle/Length: tạo đường thẳng với giá trị của góc và chiều 

dài của đường thẳng. 

 Line Horizontal/Vertical: tạo đường thẳng với giá trị khoảng cách 

(hình chiếu của đường thẳng) theo chiều X và Y. 

Ứng dụng 1: Công cụ Line để tạo các hình theo chỉ dẫn bên dưới. Lưu 

file với tên Shape 1 
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Ứng dụng 2: Công cụ Line và Move by/Move to point để tạo các hình 

học bên dưới. Lưu file với tên Shape 2 
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Ứng dụng 3: Công cụ Line Horizontal/Vertical và Line Angle/Offset 

để tạo hình bên dưới. Lưu file với tên Shape 3 

 

Ứng dụng 4: Các công cụ tạo Line để tạo hình học bên dưới. Lưu file 

với tên Shape 4 

 

Ứng dụng 5: Các công cụ tạo line để tạo hộp dạng Sleeve theo kích 

thước chú thích bên dưới. 
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2.4. Conline Tools. 

Nhóm công cụ conline giúp tạo các đường gióng, khung cho 

mẫu thiết kế. Nhóm công cụ này gồm các công cụ sau:  

 Conline Offset/Angle: Đường gióng nghiêng được tạo bằng 

cách chọn một điểm và nhập giá trị góc, giá trị góc này được xét theo 

trục X hoặc Y. Ngoài ra công cụ này còn tạo được đường gióng song 

song với đường được chọn bằng cách nhập khoảng cách từ đường 

thẳng gióng đến đường được chọn. 

 Conline Offset: Công cụ tạo đường gióng song song bằng cách 

chọn đường thẳng và nhập giá trị khoảng cách. Khoảng cách đầu tiên 

được tính từ đường được chọn đến đường gióng thứ nhất, khoảng cách 

của đường gióng thứ hai được tính từ đường gióng thứ nhất. 

 Conline At Angle From Line: Công cụ dùng để tạo đường gióng 

nghiêng từ một đường thẳng khác, giá trị góc được xét theo đường 

thẳng được chọn. 

 Conline Division/Midpoint: Công cụ dùng để chia đoạn thẳng 

thành nhiều phần bằng nhau.  

  Conline Circle: Công cụ dùng để tạo đường gióng hình tròn. 

  Conline Angle Divide: Công cụ tạo đường gióng nghiêng là 

đường phân giác của hai đường thẳng.  

 Conline Join: Công cụ tạo đường gióng là đường tiếp tuyến. 

 Conline Join With Concircle: Công cụ tạo đường gióng hình 

tròn ngoại tiếp hoặc nội tiếp đường tròn hoặc cung tròn. 

 Conline Tangent Concircle: Công cụ tạo đường gióng hình tròn 

nội tiếp tam giác. 
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Ứng dụng 1:  Sử dụng công cụ  Conline Offset/Angle,  

Conline Radius,  Conline Join with Concircle để tạo hình bên 

dưới. Lưu file với tên là Keyhole-conline.ard. 

 

Ứng dụng 2: Tạo hình bên dưới với các công cụ  Conline 

Offset/Angle,  Conline Radius,  Conline Join with Concircle. 

Lưu file với tên là Tear-coline.ard  

 

Ứng dụng 3: Sử dụng công cụ  Conline Offset/Angle,  

Conline Radius,  Conline Join with Concircle. Lưu file với tên là 

Rock-conline.ard 
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2.5. Arc Tools. 

Arc tools là nhóm công cụ tạo đường cong, mỗi công cụ có các thông 

số cần thiết lập riêng và ứng dụng trong các trường hợp riêng. 

 Arc Start Angle: Công cụ tạo cung tròn bằng cách xác định góc, 

bán kính cung tròn và kích thước hình chiếu theo chiều X hoặc chiều 

Y. 

 Arc End Point: Công cụ tạo cung tròn bằng  cách xác định kích 

thước hình chiếu theo trục X và trục Y và giá trị bán kính cung tròn. 

 Arc Center: Công cụ tạo cung tròn bằng cách xác định khoảng 

cách từ tâm cung tròn đến trục X hoặc Y, xác định bán kính cung tròn 

và kích thước hình chiếu theo chiều X hoặc Y. 

 Arc Through Point: Tạo cung tròn bằng cách đi qua các điểm. 

Chọn một điểm bắt đầu, sau đó lần lượt click qua các điểm để tạo 

thành cung tròn. 

Ứng dụng 1: Mở file 9C.ard, Sử dụng công cụ tạo cung tròn để tạo 

các cung tròn theo chú thích bên dưới  

 Sử dụng công cụ  Arc Start Angle, Line offset/angle. 

Angle = 0, Radius = 35, Offset Y = 25. 
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Angle = 10, Radius = 35, Offset Y = 25. 

 

 Sử dụng công cụ  Arc End Point, line offset/angle  

X:offset=25mm, Y:offset=35mm, Radius=46mm  

 

 Sử dụng công cụ  Arc Center, Line Offset/angle 

Center X = 25mm, Radius = 35mm, offet X = 15mm. 

 

Center X = 40mm, Radius = 50mm, offset X = 25cm. 

 Sử dụng công cụ  Arc Through Point. 
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Ứng dụng 2: Mở file 9D.ard, sử dụng công cụ Arc through point để 

vẽ hình bên dưới 

 

Ứng dụng 3: Mở file Keyhole-conline.ard, Line offset/angle, Arc 

Through Point 

 

 

Ứng dụng 4: Mở file Tear-coline.ard, Sử dụng Line offset/angle, Arc 

Through Point 
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Ứng dụng 5: Mở file Rock-conline.ard, sử dụng Arc Through Point 

 

Ứng dụng 6: Sử dụng các công cụ Conline Offset/Angle, Conline 

Circle, Conline Join With Concircle, Line tool, để tạo hình theo kích 

thước bên dưới. 
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2.6. Rectangle và offset line Tools. 

 Rectangle horiz/vert: công cụ tạo các hình học chữ nhật. Kích 

thước của hình được xác định bằng cách nhập giá trị khoảng cách theo 

trục X và Y. 

 Rectangle from Line: Công cụ này tạo các hình học chữ nhật 

từ một đường thẳng cho trước. để tạo được hình học chữ nhật, click 

chọn vào đường thẳng, drag chuột và nhập giá trị của chiều còn lại, 

Enter để thiết lập giá trị. 

Offset Line: Công cụ tạo đường thẳng có kích thước bằng với 

kích thước của đường được chọn. 

 

2.7. Circle and Ellipse Tools. 

 Circle: Công cụ dùng để tạo hình tròn. Xác định tâm và nhập giá 

trị của bán kính. 

 Elip: Công cụ tạo hình elip bằng cách xác định hình chiếu theo 

trục X và trục Y. 
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Ứng dụng 1: Sử dụng công cụ Rectangle, line offset/angle để tạo hình 

với kích thước bên dưới. 

 

 Sử dụng công cụ Circle, Move to point và move by để 

tạo hình tròn với kích thước bên dưới. 

 

 Sử dụng công cụ Elip, Move to point và move by để tạo 

hình elip với kích thước bên dưới. 

 
 

2.7. Những công cụ tạo hình đặc biệt. 
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Những công cụ Line Join, Arc Join, Tangent Arc được sử dụng tương 

tự như các công cụ  Conline Join,  Conline Join With 

Concircle,  Conline Tangent Concircle 

 

Line at angle from line: Công cụ tạo đường thẳng có giá trị hình 

chiếu theo trục Y bằng với khoảng cách giữa hai đường thẳng. 

Bezier: Công cụ tạo đường cơ. 

 Straight Curve: Tạo đường uốn cong với phần bắt đầu là đường 

thẳng và phần cuối là đường cong. 

Curve Straight: Tạo đường uốn cong với phần bắt đầu là đường 

cong và phần cuối là đường thẳng. 

Ứng dụng 1: Sử dụng công cụ Straight Curve để tạo hình bên dưới.  

 Giá trị X=15mm, Y=45mm, A1= 10mm, R=15mm. 

 

 Giá trị X=15mm, Y=45mm, A1= 10mm, R=8mm. 
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 Giá trị X=10mm, Y=45mm, A1= 0mm, R=10mm.                                                             

 

Ứng dụng 2: Mở file Special_Geom_Tools.ARD. Sử dụng công cụ 

Line Join để tạo hình bên dưới. 

  
 Sử dụng công cụ Arc Join để tạo hình bên dưới. 
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 Sử dụng công cụ Tangent Arc để tạo cung tròn nội tiếp 

trong 03 đường thẳng. 

 

 Sử dụng công cụ Line At Angle From Line để tạo đường 

nghiêng 

 

 Sử dụng công cụ Bezier để tạo các đường uốn cong. 

 

 

3. ĐỊNH DẠNG CÁC ĐƯỜNG TRONG CẤU TRÚC 

HỘP 

Một cấu trúc hộp được xem là hoàn chỉnh khi các đường 

trong cấu trúc được định dạng đúng, ví dụ như đường cắt, 

đường cấn, đường nửa đứt... 
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Để định dạng được tính chất đường, cần thực hiện theo các 

bước sau: 

Bước 1: Chọn tất cả các đường có cùng định dạng. 

Bước 2: Chọn biểu tượng tam giác trên tab menu để xổ chọn 

định dạng đường phù hợp. 

 

Nếu không tìm được loại đường muốn định dạng, chọn “other” để mở 

hộp thoại line type và tìm loại tính chất đường phù hợp. 

 

Có 2 nhóm đường: Generic type là loại đường thông dụng hay dùng 

như đường cắt, đường cấn.., Rule type là nhóm đường có quy luật, 

thường là các đường có tính chất đường lặp đi lặp lại giống nhau như 

đường nửa đứt, đường cấn-cắt, đường dán xé zipper... 

Chúng ta có thể thay đổi tính năng, quy luật của các đường Rule type 

trong “properties”. chọn đường cần thay đổi  >  click chuột phải > 
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chọn properties > chọn tape “special rule” > thay đổi các thông số > 

lưu lại với tên mới 

 

 

4. BÀI TẬP ỨNG DỤNG 

Sử dụng các công cụ hổ trợ thiết kế: current point, line tool, 

conline, rectangle, circle, arc tool để vẽ các dạng hộp sau: 
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BÀI 4: CHỈNH SỬA MẪU CẤU TRÚC BAO BÌ 

HỘP VỚI NHÓM CÔNG CỤ EDIT, ADJUST 

 

Mục tiêu bài học: 

Sau bài học này sinh viên sẽ có khả năng: 

- Hiểu được tính năng của nhóm công cụ Edit, Adjust. 

- Chỉnh sửa được hình dạng của mẫu cấu trúc. 

- Tạo được mẫu cấu trúc hộp dạng hình chóp cụt, hình nón, khay 

6 góc, khay 4 góc, hình hộp lục giác và các dạng hình hộp đặc 

biệt…với các nhóm công cụ Edit, Adjust 

1. EDIT TOOL. 

Nhóm công cụ Edit dùng để chỉnh sửa và copy đối tượng. Bao gồm 

những công cụ sau: 

 Move (ctrl + M): Công cụ dùng để di chuyển đối tượng đến một 

vị trí bất kỳ. 

 Move Layer: Chuyển các chi tiết từ layer này đến layer khác. 

Nhóm công cụ Rotate dùng để xoay đối tượng.  

 Rotate Left 90: Đối tượng xoay 90
0
 về bên trái (ngược chiều 

kim đồng hồ). 

 Rotate Right 90: Đối tượng xoay 90
0
 về bên phải (cùng chiều 

kim đồng hồ).  

 Rotate 180: Đối tượng xoay 180
0
 

 General Rotate: Xoay đối tượng quanh một điểm được chọn. 

Ngoài ra, còn có các công cụ vừa copy vừa xoay đối tượng vừa được 

copy. 
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Nhóm công cụ Mirror cũng là nhóm công cụ dùng để lật đối tượng 

theo phương đặc biệt, bao gồm các công cụ sau: 

 Mirror about Vertical: Công cụ dùng để lật đối tượng qua trục Y 

(chiều đứng) và di chuyển đối tượng đến một vị trí mới. 

 Mirror about Horizontal: Công cụ dùng để lật đối tượng qua 

trục X (chiều ngang) và di chuyển đối tượng đến một vị trí mới. 

 Vertical mirror about center: Công cụ dùng để lật đối tượng qua 

trục Y (chiều đứng). 

 Horizontal mirror about center: Công cụ dùng để lật đối tượng 

qua trục X (chiều ngang). 

 Mirror about line: Công cụ dùng để lật đối tượng qua một đường 

thẳng. 

Trong nhóm công cụ Mirror, ngoài các công cụ lật đối tượng còn có 

các công cụ copy đối tượng và lật đối tượng vừa copy. Chức năng các 

công cụ copy và lật này tương tự các công cụ lật. 
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 Scale: Thu nhỏ hoặc phóng to đối tượng theo tỷ lệ được thiết lập. 

 Differential Scale: Thu nhỏ hoặc phóng to đối tượng với tỷ lệ 

được thiết lập theo trục X và Y. 

 Copy: Công cụ dùng để copy đối tượng và di chuyển đối tượng 

đến một vị trí mới. 

 Repeated Copy: Được dùng để copy đối tượng, lệnh copy sẽ 

được thực hiện liên tục cho đến khi tắt chức năng này. 

 

 Chọn điểm đặt đối tượng vừa được copy. 

 Đặt đối tượng vừa được copy ở điểm bất kỳ.  

 Copy Times offset: Copy đối tượng với số lượng và khoảng cách 

được thiết lập. 

 Copy Times Rotate: Copy đối tượng với số lượng và góc xoay 

được thiết lập. 

 Offset line: Tạo đường song song với đường thẳng hoặc những 

dường bao quanh một đối tượng với khoảng cách được thiết lập.  
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Ứng dụng 1: Mở file Editlayers.ard. Chuyển các chi tiết kích thước 

sang layer Dimension. Lưu file với tên Layer.ard 

 

Ứng dụng 2: Mở file 11A.ard. Sử dụng công cụ Move di chuyển phần 

nắp cài đến vị trí bên dưới. Lưu file với tên Adjust11A.ard 

                      

Ứng dụng 3: Mở file 11B.ard. Sử dụng các công cụ xoay, copy để tạo 

hình bên dưới. Lưu file với tên Adjust 11B.ard 

  

Ứng dụng 4: Mở file 11C.ard. Sử dụng các công cụ copy đối xứng để 

tạo hình bên dưới. 
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Ứng dụng 5: Sử dụng công cụ conline Radius, conline offset, Copy 

Times Rotate để tạo hình tam giác, ngũ giác, lục giác, bát giác có kích 

thước cạnh là 100cm. 

 

      

 

Ứng dụng 6: Mở file Offsetlines.ard Thử nghiệm công cụ offset line 

với các hình có trong file. 

 

2. ADJUST TOOL. 

Trim/Extend Two lines: Công cụ dùng để cắt hoặc nới rộng hai 

đường thẳng. 

 Trim/Extend One line: Công cụ dùng để cắt hoặc nới rộng một 

đường thẳng. 

 Trim Interior: Công cụ dùng để cắt những phần nằm bên trong. 

 Trim Against Selection: Công cụ dùng để cắt phần không được 

chọn. 
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Ứng dụng 1: Mở file 12A.ard. Sử dụng 4 công cụ trên để chỉnh sửa 

thành hình bên dưới. 

 

 

Ứng dụng 2: Mở file 12B.ard. Sử dụng 4 công cụ trên để chỉnh sửa 

file thành hình bên dưới. 

 

 Blend: Công dụng dùng để tạo góc bo cho đối tượng. 

 Split line: Công cụ dùng để cắt đối tượng ở bất kỳ vị trí nào. 

Ứng dụng 3: Mở file 12C.ard. Sử dụng 06 công cụ trên để sửa file 

thành hình bên dưới. 
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 Chamfer: Công cụ dùng để tạo đường nghiêng ở góc của hai 

đường thẳng bằng cách nhập giá trị. Khi chọn công cụ này, trên thanh 

status sẽ hiển thị 03 cách để nhập giá trị. 

Chamfer equal distance: Kích thước hình chiếu của đường nghiêng 

theo trục X và Y bằng nhau. 

 

Chamfer two distance: Kích thước hình chiếu của đường nghiêng 

theo trục X và Y có giá trị khác nhau. 

  

Chamfer distance/angle: Góc nghiêng, kích thước hình chiếu của 

đường nghiêng theo trục X. 

  

Ứng dụng 4: Mở lại file 12C.ard. Sử dụng công cụ Chamfer để sửa 

file thành hình bên dưới. 

 

 Stretch by Polygon: Công cụ dùng để kéo giãn hoặc thu ngắn 

đối tượng theo trục X hoặc Y.  
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Ứng dụng 4: Mở file 12D.ard. Sử dụng công cụ Stretch by Polygon 

để sửa kích thước chiều dài từ 302mm thành 327 mm và 304 mm to 

329 mm. 

 

 Stretch Point: Công cụ dùng để kéo dãn, thu ngắn đối tượng tại 

một điểm. 

Ứng dụng 5:  Mở lại file 12D.ard. Sử dụng công cụ Stretch Point để 

sửa cửa sổ thành hình bên dưới với giá trị góc = 45, Offset X= 25.  

 

Ứng dụng 6: Mở lại file Adjust11A.ard . Sử dụng các công cụ trong 

nhóm công cụ edit để sửa các vị trí bị lỗi. 
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3. BÀI TẬP ỨNG DỤNG 

Sử dụng các công cụ hổ trợ thiết kế: current point, line tool, conline, 

rectangle, circle, arc tool và công cụ edit, adjust để vẽ các dạng hộp 

sau: 
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BÀI 5: CHUYỂN ĐỔI CẤU TRÚC HỘP TỪ 

KHỔ   TRẢI 2D SANG DẠNG 3D. 

 

Mục tiêu bài học: 

Sau bài học này sinh viên sẽ có khả năng: 

- Dựng được mẫu cấu trúc từ dạng 2D sang 3D bằng các công 

cụ gấp. 

- Quan sát mẫu hộp với các chế độ view khác nhau. 

- Sắp xếp được các mẫu cấu trúc hộp khác nhau trong không gian 

3D. 

- Giả lập cách sắp xếp, di chuyển hộp trong không gian 3D. 

- Giả lập được không gian đặt mẫu cấu trúc bằng hình nền, nguồn 

sáng. 

- Tạo, xuất được file video mô phỏng các bước gấp mẫu cấu 

trúc hộp. 

 

1. DỰNG MẪU CẤU TRÚC TRONG KHÔNG GIAN 3D 

Artios 3D được sử dụng để chuyển các cấu trúc hộp từ dạng phẳng 

(2D) sang dạng 3D bằng việc mô phỏng lại cách gấp dựng hộp trong 

thực tế, các đường cấn sẽ được chọn và thiết lập một góc gấp phù hợp. 

Điều này giúp người thiết kế có thể kiểm tra mẫu cấu trúc hộp trước 

khi bắt đầu sản xuất, tránh lãng phí thời gian, tiền bạc, và vật chất. 

Để mở các công cụ trong 3D, chúng ta chọn View trên thanh menu 

> Toolbars…> click chọn biểu tượng của các nhóm công cụ muốn sử 

dụng. Hoặc có thể chọn All on để mở tất cả các nhóm công cụ. 
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Mẫu cấu trúc hộp tạo ra trong 2D có thể được chuyển đổi thành dạng 

3D bằng các công cụ gấp: 

 Fold All: các đường cấn sẽ được gấp cùng 1 góc gấp, 

thường dùng cho cấu trúc hộp có dạng hình hộp chữ nhật. 

 Fold Angle: Mỗi đường cấn sẽ được thiết lập 1 góc gấp 

riêng. 

 Fold 1 to meet: Cấu trúc hộp được dựng bằng cách chọn 

hai đường cấn liền kề hai      đường cắt thuộc hai mặt phẳng 

giao nhau.            
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 Fold 2 to meet: Cấu trúc hộp được dựng bằng cách chọn 

hai đường cắt liền kề một đường cấn thuộc hai mặt phẳng giao 

nhau. 

 

1.1 Gấp dựng hộp với công cụ Fold Angle và Fold All 

Việc dựng mẫu thiết kế từ 2D sang 3D sẽ bao gồm các bước sau:  

Bước 1. Mở mẫu cấu trúc hộp cần gấp ở dạng khổ trải (2D). 

Bước 2. Chuyển thiết kế từ 2D sang 3D. có 3 cách để thực hiện: 

 Click chọn Convert to 3D từ menu File  

 Click biểu  tượng Convert to 3D  trên thanh View Bar  

 Sử dụng phím tắt Ctrl + 3 

Bước 3. Chọn mặt phẳng gấp. Sau khi Convert, hộp thoại Set Base 

Face sẽ mở ra. Chọn 1 mặt phẳng làm mặt cơ sở, click OK.  
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Đối với những mẫu cấu trúc đã từng được gấp và chúng ta muốn 

sử dụng lại các góc gấp trước đó, chúng ta có thể click chọn ở ô Use 

previous fold angles trong hộp thoại Set Base Face sau đó click 

OK. 

 

 

Bước 4. Thiết lập góc gấp phù hợp cho mẫu cấu trúc hộp: Sử dụng 

công cụ Fold Angle , click chọn vào đường cấn cần gấp (giữ 

phím Ctrl/Shift khi muốn chọn nhiều đường cấn cùng lúc), nhập giá 

trị góc gấp vào ô Angle.  

 

 

 

 

 Nếu tất cả các đường cấn đều có chung 1 góc gấp, chúng ta có 

thể chọn công cụ Fold All , chọn 1 đường cấn và nhập góc gấp 

phù hợp để dựng hộp, hoặc có thể cick thanh trượt để xem mẫu cấu 

trúc di chuyển. 
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Lưu ý: Click vào mũi tên trái hoặc phải trên thanh trượt thay đổi 

góc trong một mức độ. Nhấp chuột trong vùng xám thay đổi góc giá 

trị gia tăng mười mức độ. Nếu muốn sao chép góc gấp của một đường 

cấn nào đó, chúng ta có thể sử dụng nút “Same as…”  

 

1.2 Gấp dựng hộp với công cụ Fold 1 to meet và Fold 2 to meet. 

Đối với một số cấu trúc hộp đặc biệt không thể xác định chính xác góc 

gấp, chúng ta có thể sử dụng công cụ  Fold 1 to Meet và  

Fold 2 to Meet để dựng hộp. Để có thể hiểu rõ hơn về hai công cụ này, 

chúng ta thực hiện theo hướng dẫn của ứng dụng 1 bên dưới 

Ứng dụng 1 

Bước 1: Mở file Pentagon.A3D.  

Bước 2: Dùng công cụ Fold 2 to Meet để bắt đầu. Thực hiện theo các 

hướng dẫn ở dưới cùng của mà n hình lựa chọn đường cắt đầu tiên và 

đường cấn đầu tiên, đường cấn thứ hai và đường cắt thứ hai từ thiết kế 

được gấp lên. 
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Bước 3: Dùng công cụ Fold 1 to Meet chọn một đường cắt khác và 

một đường cấn có  liên quan sau đó chọn một đường cắt thiết kế 

đường gấp lại. Tiếp tục với công cụ này để kết thúc gấp nửa đầu tiên. 

 

Hoàn thiện phần còn lại bằng cách click chọn các đường cấn còn lại  click nút 

“Same as…”  chọn đường cấn đã gấp. 

 

 

 

2. CÁC CHẾ ĐỘ VIEW 3D. 

Sau khi đã gấp dựng cấu trúc hộp, chúng ta có thể sử dụng 

nhóm công cụ View để quan sát mẫu cấu trúc trong không gian 

3D.  
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Thanh công cụ View chứa những công cụ sau: 

 Zoom Rectangle: Dùng để phóng to vùng quan sát. Chúng 

ta click chuột vào vị trí muốn phóng to hoặc Drag chuột xung 

quanh  khu vực cần phóng to.  

 Zoom Out: Dùng để thu nhỏ vùng quan sát. Chọn công cụ và click 

hoặc drag chuột để thu nhỏ hình ảnh. 

 Zoom in/out: Dùng để phóng to hoặc thu nhỏ vùng làm việc trong 

cùng một thao tác, bằng cách giữ nút trái chuột và drag chuột trong không 

gian làm việc để phóng to hoặc thu nhỏ. 

Chúng ta cũng có thể sử dụng con lăn của chuột để thu phóng không 

gian làm việc mà không cần chọn các công cụ Zoom. 

 Scale to fit: Đưa thiết kế về trung tâm cửa sổ. 

   Scale to fit with border: Thu thiết kế về trung tâm 1 giới 

hạn 25%, có thể thay đổi trong default. 

 Pan: Click và kéo thiết kế di chuyển lên/ xuống/ trái hoặc phải. 

 Rotate Right: Xoay phải 90
0
. 

 Rotate Down: Xoay xuống 90
0
. 

 Orthogonal view: Chuyển thiết kế về mặt phẳng quan sát gần 

nhất, giống như khi quan sát các mặt cắt của một vật thể. Nếu thiết kế 

đang được xem gần với trục X, Z thì khi sử dụng công cụ này, cấu trúc 

hộp sẽ chuyển về mặt phẳng chứa trục X, Z. 
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 Perspective: Tạo phối cảnh không gian, gần lớn, xa nhỏ. Khi 

chọn công cụ này thì thanh trượt hiển thị phía bên dưới di 

chuyển để thay đổi góc phối cảnh và có thể check để tắt hoặc mở 

nó. 

 

 

 Light Source: Thay đổi góc hoặc màu của đèn, thêm bóng đèn. 

 View Angle: Cho phép thay đổi góc quan sát mẫu thiết kế bằng 

cách rê chuột hoặc xoay bằng cách nhấn Ctrl/ drag chuột. 

 

Chọn công cụ View Angle nhập một góc cụ thể hoặc kéo thanh 

trượt để thay đổi góc xem theo trục ngang X. 
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Chọn công cụ View Angle nhập một góc cụ thể hoặc kéo thanh trượt 

để thay đổi góc xem theo trục đứng Z 

    

 

Chọn công cụ View Angle nhập một góc cụ thể hoặc kéo thanh trượt 

để thay đổi góc xem theo trục xuyên Y 

    

Nếu click và drag chuột trong không gian làm việc khi chọn 

công cụ View Angle cả ba góc độ sẽ được thay đổi. Nó cho 

phép xoay thiết kế lên, xuống, qua trái hoặc phải. Giữ phím 

Ctrl trong khi kéo chuột xoay thiết kế sẽ xem được các mặt. 

  View Mode: Cho phép lựa chọn các chế độ view khác 

nhau. Có 3 cách để thay đổi cách hiển thị của thiết kế:  
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 Chọn View Mode từ menu View. Lựa chọn các tùy chọn khác 

nhau sẽ thay đổi cách hiển thị của thiết kế. Nhấn Apply để thay 

đổi chế độ xem cho thiết kế. 

 

 Click chuột phải trên màn hình để chọn các hiển thị. 

 

 Chọn các nhóm công cụ View mode trong Toolbars.. 

 

Chúng ta có thể lựa chọn cách hiển thị của thiết kế qua các chế độ sau: 

 Solid,  Solid with edges,  Lighter color with edges,  

Hidden line removed,  Wire frame. 
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   Hidden lines Removed dùng để kiểm tra thứ tự gấp 

chưa đúng. Khi sử dụng công cụ Fold All, các cạnh và nắp có thể 

không được gấp vào trong theo đúng thứ tự. Áp dụng tùy chọn này 

chúng ta sẽ phát hiện những đường cấn chưa đúng thứ tự. 

 

 Nếu cấu trúc đã được áp hình ảnh đồ họa ở dạng 2D, thì khi 

chuyển sang 3D chúng ta cũng có thể thấy được hình ảnh này. Click 

chọn vào ô Graphics trong hộp thoại view mode, hoặc click chuột 

phải trên màn hình và chọn hàng Graphics. Hoặc chọn công cụ 

Graphic trong nhóm View Mode 

 

Click chọn  Board thickness để quan sát độ dày của vật liệu.  
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Click chọn  Transparent làm cho thiết kế trong suốt để có thể 

xem các bộ phận, chi tiết ẩn. 

 

Click chọn  Creases pink cho thấy các đường cấn màu hồng, có 

đầy đủ các màu xanh và  đường partial cut màu tím, để có thể phân 

biệt giữa đường với nhau. Khi nó không check các đường giống màu 

giấy. 

Click chọn 
 
Bounding Box khi muốn xem 3 kích thước không 

gian của cấu trúc hộp. Chúng ta có thể sử dụng công cụ này để xác 

định kích thước hộp sau khi đã được gấp hoàn chỉnh.
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3. SẮP XẾP CẤU TRÚC HỘP TRONG KHÔNG GIAN 

3D. 

 Artios 3D cho phép chúng ta làm việc với nhiều mẫu cấu trúc 

trong cùng 1 Window, vì vậy chúng ta có thể giả lập cách sắp xếp các 

hộp sản phẩm vào các thùng lớn, hoặc lắp ghép các mãnh chi tiết để 

tạo thành kệ trưng bày, sản phẩm nội thất…hoặc sản phẩm có cấu trúc 

đặc biệt. 

 

3.1 Di chuyển, thêm và sao chép mẫu cấu trúc trong 3D 

3.1.1 Thêm mẫu cấu trúc trong 3D.  

 Để thêm một thiết kế khác vào window 3D đang làm việc, 

chúng ta chọn Add a design từ menu File. Nếu mẫu thiết kế khác 

đang được mở ở dạng 2D, chúng ta có thể Convert to 3D > click 

chọn vào ô Add to 3D > chọn file 3D để thêm mẫu thiết kế vào > 

Click OK 

 

3.1.2 Di chuyển mẫu cấu trúc trong 3D 

 Thiết kế trong không gian làm việc 3D có thể được di chuyển 

bằng các công cụ sau: 

 Move Designs: cho phép di chuyển đối tượng theo tọa độ của 

từng trục X,Y hoặc Z.  
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Chọn mẫu cấu trúc > chọn công cụ Move Designs > xác định vị trí 

góc tọa độ (điểm pickup trên thiết kế > Chọn trục tọa độ muốn di 

chuyển > nhập khoảng cách di chuyển (có thể là giá trị âm). 

 

 Move Designs in X, Y, Z: Di chuyển đối tượng theo cả 3 tọa độ 

của trục X, Y và Z.  

Chọn mẫu cấu trúc > chọn công cụ Move Designs in X, Y, Z > xác 

định vị trí góc tọa độ (điểm pickup) trên thiết kế > nhập tọa độ X,Y,Z 

> click OK 

 

 Move point to point:  Di chuyển đối tượng bằng cách neo vào 

một vị trí xác định trên cùng thiết kế hoặc trên các thiết kế khác. 

Khoảng cách di chuyển chính là khoảng cách giữa điểm pickup và 

điểm put down. 

Chọn mẫu cấu trúc > chọn công cụ Move point to point > Xác định 

điểm pickup > xác định điểm put down. 

3.1.3 Sao chép mẫu cấu trúc trong 3D 

Chúng ta sao chép thiết kế bằng công cụ Duplicate Design . Để 

sao chép và di chuyển đối tượng copy, chúng ta thực hiện theo các 

bước sau:  

Chọn mẫu thiết kế> chọn công cụ Duplicate Design  > nhập số 

lượng copy > chọn góc toạ độ (điểm Pickup) trên mẫu thiết kế > chọn 
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trục toạ độ để di chuyển đối tượng copy > nhập khoảng cách muốn di 

chuyển hoặc điểm neo cho các đối tượng copy.  

   

 

 

3.1.4 Xoay một thiết kế 3D 

Công cụ Rotate Designs  dùng để xoay một thiết kế trong không 

gian 3D. Chúng ta thực hiện theo các bước sau: 

Chọn đối tượng cần xoay > chọn công cụ Rotate Designs > 

chọn trục toạ độ để xoay đối tượng > nhập giá trị góc xoay.  
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4. GIẢ LẬP KHÔNG GIAN TRƯNG BÀY MẪU HỘP 

4.1 Đặt hình ảnh nền. 

Chế độ View Mode trong không gian 3D cho phép chúng ta giả lập lại 

không gian trưng bày mẫu hộp bằng cách đặt hình nền – background 

cho không gian làm việc 3D. 

Chọn View > View Mode > chọn Background image > ấn nút  > 

chọn đường dẫn đến hình nền cần đặt > Click OK. 
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Nếu không sử dụng hình nền, chúng ta có thể thay đổi màu sắc của 

phông nền – Background color trong View Mode.  

 

4.2 Nguồn sáng. 

Nguồn sáng trong không gian làm việc 3D sẽ giúp mẫu thiết kế trong 

thực hơn, giống với không gian thực tế. Chọn menu View > Light 

Source hoặc chọn công cụ Light Source  để xem vị trí các 

bóng đèn. Chúng ta có thể click chọn vào bóng đèn và di chuyển đến 

các góc độ khác nhau để quan sát mẫu thiết kế. 

 

 

 

Chúng ta cũng có thể thêm hoặc bớt các bóng đèn. Số bóng đèn tối đa 

có thể thêm vào không gian làm việc là 8. 
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Màu sắc và độ sáng của đèn đại diện cho màu sắc và độ sáng của 

ánh sáng. Nhấp đúp lên một đèn chọn màu sắc đèn theo không gian 

RGB (View > Ambient Light). 

 

 

 

5. TẠO MÔ PHỎNG GẤP CHO MẪU CẤU TRÚC HỘP 

5.1 Tạo video mô phỏng gấp. 

 Một video mô phỏng gấp sẽ giúp chúng ta dễ hình dung cách 

gấp dựng hộp, các video này có thể chuyển cho khách hàng. Nhóm 

công cụ Animation trong 3D cho phép chúng ta tạo mới, chỉnh sửa, 

xem trước video mô phỏng gấp. 
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5.1.1 Tạo mới một video mô phỏng gấp. 

Chúng ta sử dụng công cụ Add frame  để tạo video mô phỏng, 

quy trình thực hiện gồm các bước sau: 

Bước 1: Mở file thiết kế ở dạng 2D  convert to 3D hoặc mở trực 

tiếp file 3D của mẫu thiết kế đó. 

Bước 2: Click vào công cụ Add frame để chụp hình mẫu thiết 

kế ở dạng khổ trải.  

Bước 3: Dùng công cụ Fold angle  để chọn vạch gấp, nhập giá 

trị góc gấp phù hợp để dựng hộp. 

Bước 4: Nhấn Add frame  để chụp hình ảnh mẫu thiết kế vừa 

được thay đổi. 

Tiếp tục chọn vạch gấp tiếp theo, nhập giá trị góc gấp phù hợp và 

click add frame sau mỗi thao tác gấp. Thực hiện tương tự cho đến khi 

mẫu thiết kế được dựng hoàn chỉnh. 

 

Bước 5: Chọn File > Output-3D > Animation – AVI > Chọn chế độ 

xem, kích thước khung hình của video > Click OK để xuất file video 

mô phỏng.  
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Lưu ý: Khi xuất file video, chúng ta cần chọn góc view, kích thước thu 

phóng phù hợp vì file video sẽ lấy góc view tại thời điểm xuất file. Để 

tránh tình trạng sai góc view, chúng ta click chọn chế độ “Scale to fit 

every frame” file video sẽ tự điều chỉnh thu phóng góc nhìn của mẫu 

thiết kế khi gấp. 

        

 

5.1.2 Chỉnh sửa video mô phỏng gấp. 

Để xem lại các bước gấp của thiết kế, chúng ta sử dụng công cụ 

Animation Playback . Chúng ta có thể chỉnh sửa video ở các 

mục sau: 
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 Thay đổi thời gian trình chiếu của từng bước gấp: nhập thời 

gian muốn duy trì bước gấp đó trong ô Duration bên dưới cửa 

số làm việc.  

 

 Bỏ bước gấp trong trình tự gấp: chọn playback > nhấn 

play  đến bước gấp muốn bỏ > nhấn công cụ delete .  

 Thêm bước gấp trong trình tự gấp: chọn playback > 

nhấn play  đến trước vị trí bước gấp muốn thêm > chọn 

vạch gấp muốn thêm > nhập giá trị góc gấp phù hợp > chọn 

công cụ Add frame . 

 Thay đổi bước gấp: chọn playback  > nhấn play  đến 

trước vị trí bước gấp muốn thay đổi > thực hiện việc thay đổi > 

nhấn Update frame  để cập nhật. 

5.2 Tạo hướng dẫn gấp bằng hình ảnh. 

Một Assembly Drawing giống như “tờ hướng dẫn gấp” cho mẫu cấu 

trúc. Assembly Drawing có thể tạo ra trong ArtiosCAD 3D. Chúng 

ta thực hiện các bước như tạo file video mô phỏng. Chọn Animation – 

DOC khi xuất file. Chọn chế độ xuất file phù hợp > click OK để xuất 

file. Thêm các chú thích, hướng dẫn cho các hình trong file Word 
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6. BÀI TẬP ỨNG DỤNG 

Bài tập 1: Mở file 2B_FOLDED.ard. Thực hiện gấp dựng hộp.  

Bài tập 2: Mở file Munchies.ard, thực hiện gấp dựng hộp. Mở thêm 

file Esko_Shipper.A3D vào vùng làm việc, sắp xếp các hộp 

Munchies và đặt vào hộp Esko_shipper như hình bên dưới.  

 

Bài tập 3: Mở file Partition.ARD sắp xếp mẫu thiết kế như hình bên 

dưới 
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Bài tập 4: Mở file Tray_Header.A3D, tạo các bước gấp mô phỏng 

gấp cho mẫu thiết kế. Xuất thành file video, file word (.doc), file 

powerpoint (.ppt). 

Bài tập 5: Thực hiện gấp, tạo mô phỏng, xuất file video cho các mẫu 

thiết kế được vẽ ở Bài 3 trang 57. 
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BÀI 6: ĐẶT THIẾT KẾ ĐỒ HỌA VÀO MẪU 

CẤU TRÚC HỘP. 

 

Mục tiêu bài học: 

Sau bài học này người học sẽ có khả năng: 

- Biết được các định dạng file hình sử dụng trong phần mềm 

ArtiosCAD. 

- Tạo được đường tràn lề - bleed cho mẫu thiết kế. 

- Đặt được hình ảnh đồ họa lên khổ trải của mẫu cấu trúc theo 

đường bleed. 

- Tạo, tô màu, chỉnh sửa cho các hình dạng khác nhau. 

- Tạo các đường cắt theo hình dạng của hình đồ họa.  

 

Nhóm công cụ ArtMaker cho phép chúng ta tạo hoặc đặt các hình 

đồ họa lên file thiết kế cấu trúc. Chúng ta có thể nhập hình ảnh đồ họa 

vào file khuôn bế đã thiết kế theo đường viền ngoài của file thiết kế, 

hoặc là đường tràn lề (bleed), hoặc tạo hẳn một đường viền riêng chỉ 

để áp hình ảnh bitmap vào. 
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1. Các định dạng file có thể đặt.  

Những file nội dung được nhúng hình bitmap, tô pattern hoặc tô 

chuyển màu xử lý tốt hơn trong ArtiosCAD nếu chúng được lưu với 

file đuôi TIFF, JPEG, BMP hoặc PDF. 

Khi một file bitmap được thêm vào không gian làm việc, cần chú ý vị 

trí của những nút canh chỉnh bằng tay (handles) của những đường bao 

xung quanh hộp. Nếu handles được đặt ở vị trí xa hơn cạnh của mẫu 

khuôn bế thiết kế, nó có thể chỉ ra sự tồn tại của những đối tượng ẩn 

mà đã được che (“masked out”) bởi người thiết kế đồ họa. 

Lưu ý: Những hình ảnh với định dạng EPS khi đặt vào sẽ là những 

đường path rời rạc, vì vậy khi điều chỉnh cần phải cẩn thận hoặc group 

lại lập tức ngay sau khi đặt vào không gian làm việc của CAD bằng 

công cụ Group trong thanh công cụ. 

 

2. Tô màu cho thiết kế cấu trúc hộp.  

Công cụ color stock  cho phép chúng ta tô màu cho các mặt của 

thiết kế cấu trúc. chọn biểu tưởng công cụ color stock hoặc vào tool > 

graphic > color strock > hộp thoại color stock sẽ xuất hiện > chọn mặt 

cần tô màu tương ứng (outside hay inside). 

 

Khi dùng công cụ color stock thì trong layer sẽ tự tạo một layer mới 

có tên Outside (mặt ngoài) hoặc Inside (mặt trong) Graphics tương 

ứng với mặt được chọn tô màu. 
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Để chỉnh sửa màu stock color, ta chọn lại công cụ Stock color. Hộp 

thoại Color stock sẽ hiển thị lại và thay đổi màu và chọn OK. Một hộp 

thoại Replace Graphics sẽ được mở. Chọn OK để thay thế màu đồ họa. 

 

 

3. TÔ MÀU CHO MỘT VÙNG KHÔNG GIAN 

(PANNEL) TRÊN MẪU THIẾT KẾ. 

Nhóm công cụ graphic còn cho phép chúng ta tô màu cho từng đối 

tượng khép kín, chỉnh sửa kích thước đường viền, di chuyển đối tượng 

lên trước hoặc lùi về sau như: Fill, Strock, Fill pannel, send to front, 

send to back. Vùng cần tô màu phải đảm bảo là dạng khép kín, được 

group lại. Chọn công cụ Fill pannel, click chuột vào vùng cần tô màu.  
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4. ĐẶT FILE ĐỒ HỌA VÀO THIẾT KẾ CẤU TRÚC 

CÓ ĐƯỜNG BLEED 

Để đặt file thiết kế đồ họa vào thiết kế cấu trúc chúng ta thực hiện theo 

các bước sau: 

Bước 1: Tạo đường bleed cho thiết kế. Chọn công cụ Bleed trong 

nhóm công cụ Adjust.  

 

Chọn create outside Bleed layer để tạo layer chứa đường bleed 

 

Nhập giá trị đường bleed muốn tạo trong ô Offset > Click OK, lưu ý 

đường bleed tạo trong file cấu trúc phải tương ứng với đường bleed 

tạo trong file đồ họa. 

 

Hoặc chúng ta có thể tự tạo đường bleed tùy ý bằng công cụ vẽ, sau đó 

định dạng các đường đó thành các đường outside bleed. Khi tạo 

đường bleed nên tạo trên layers outside Bleed để tiện làm việc và xuất 

file.  

Bước 2: Nhập file đồ họa dạng bitmap, JPEG vào file cấu trúc hộp. Sử 

dụng lệnh Import file từ menu File hoặc dùng công cụ Add Graphics 

 để đặt hình ảnh đồ họa vào file thiết kế cấu trúc. 
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Bước 3: Xác định vị trí cho file đồ họa. Chọn công cụ Register 

Bitmap  làm việc với phần lớn của các file đồ họa phổ biến có 

định dạng bitmap, JPEG. 

 

Khi chọn outside Bleed outline, scale to fit thì file thiết kế sẽ được 

thu phóng vừa với đường bleed.  
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5. TẠO ĐƯỜNG CẮT, CẤN THEO HÌNH ẢNH ĐỒ 

HỌA 

Một số cấu trúc hộp được thiết kế có phần đục lỗ cửa sổ với các hình 

thù đặc biệt như ngôi nhà, thú vật, xe cộ... hoặc theo hình dáng của 
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ảnh đồ họa. thì việc vẽ lại các đường nét này bằng các công cụ vẽ của 

phần mềm ArtiosCAD sẽ gặp nhiều khó khăn. Chúng ta có thể sử 

dụng công cụ Autotrace bitmap  nếu là file dạng ảnh, file dạng 

PDF và EPS cũng có thể được đặt vào phần mềm để giải quyết vấn đề 

này. 

5.1 Công cụ Autotrace bitmap 

Công cụ này sẽ tự động tạo được đường viền chung quanh hình ảnh 

bitmap được nhập vào phần mềm. chúng ta chỉ cần chọn và định dạng 

lại các đường này thành đường cấn hoặc bế. Và cũng có thể sử dụng 

đường vẽ lại để che một vài đối tượng không cần thiết bên dưới nền 

của hình ảnh.  

Các bước để đường cắt theo hình dạng ảnh đồ họa được thực hiện như 

sau: 

Bước 1 : Nhập hình ảnh đồ họa cần tạo đường cắt bằng lệnh Import 

(Ctrl + I) hoặc sử dụng công cụ Add graphic. 

Bước 2: Sử dụng công cụ Autotrace bitmap  để tạo đường line 

bao quanh hình ảnh bitmap. Hộp thoại AutoTrace bitmap sẽ xuất hiện. 

chọn màu sắc cho đường biên vừa tạo, thay đổi độ nét của các đường 

biên. 

 

Chọn vào nút Apply để thấy được kết quả. Chọn vào Dynamic sẽ thấy 

đường path thay đổi ngay khi di chuyển trên thanh trượt. click OK sau 

khi đã điều chỉnh thông số. 
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Lưu ý: Do hình được đặt vào là dạng file ảnh nên sẽ có nhiều đường 

biên được tạo, chúng ta chọn 1 đường biên gần với hình dáng muốn vẽ 

rồi dùng các công cụ Adjust outline để chỉnh sửa lại. Các đường 

clipping path này cũng có thể được dùng để cắt hình ảnh đồ họa được 

nhập vào phần mềm ArtiosCAD. 

 

5.2 Nhập một file đồ họa với định dạng là eps, pdf 

Chọn lệnh Import file từ menu File hoặc dùng công cụ Add Graphics 

để đặt một hình ảnh có định dạng EPS/PDF vào không gian làm việc 

của CAD. Trong hộp thoại Import EPSF Options chọn vào Import as 

Graphics. File thiết kế sẽ được đặt vào với chức năng như một hình đồ 

họa. 

 

Nếu chọn Convert Stockes to lines và Convert Fills to lines thì file sẽ 

được chuyển thành các đường line. Nhấp chuột OK và hộp thoại 

Importing EPSF sẽ được mở ra. chọn mặt thiết kế Design side là mặt 

trong hay mặt ngoài, Die side là mặt dao hay mặt lưng của khuôn bế. 
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Hình ảnh sẽ được đặt vào không gian làm việc. Chọn đường ngoài 

cùng để làm đường bao của hình ảnh. Di chuyển đường bao đã chọn 

sang một bên và đổi thành đường cắt là ta sẽ có được hình ảnh cửa sổ 

như ý muốn từ file eps. 

 

Chúng ta có thể sử dụng công cụ drawing hoặc công cụ adjust outline 

để chỉnh đường path nếu cần. 
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6. CẮT XÉN HÌNH ẢNH ĐỒ HỌA 

Bất cứ một đường path khép kín nào cũng có thể sử dụng như một 

đường clipping path trong ArtiosCAD. Đường clipping path có thể sử 

dụng để che một đối tượng không cần thiết trong vùng background. 

Bước 1: Chọn công cụ Clip Graphics và làm theo những chỉ dẫn trên 

thanh trạng thái. 

Bước 2: Chọn hình ảnh bitmap bằng cách nhấp chuột vào cạnh của 

khung bao. 

 

Bước 3: Chọn clip path bằng cách nhấp chuột vào cạnh của những 

đường đã được vẽ lại và nhóm (group) lại. Nhấp chuột vào nút OK 

trên thanh trạng thái. 

 

 

7. BÀI TẬP ỨNG DỤNG 

Bài tập 1: Mở file HOTOILBX.ard và file Hotoilbx.jpg, đặt file đồ 

họa theo đường bleed đã tạo sẵn như hình bên dưới. 
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Bài tập 2: Mở file Display_Design.ARD, Display_Design.JPG, đặt 

file thiết kế theo các đường vẽ cấu ttruc1 để được hình bên dưới. 

 

Bài tập 3: Mở file Logobox3.ard sử dụng công cụ autotrace bitmap và 

công cụ clip graphic để tạo file như bên dưới 
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Bài tập 4: Tạo cửa số có kiểu dáng đặc biệt bất kỳ trong một mẫu hộp 

ứng dụng công cụ autotrace bitmap và bằng cách đặt file eps, pdf vào 

mẫu thiết kế cấu trúc. 

Bài tập 5: Tự tạo đường bleed cho mẫu hộp, xuất thành file eps, thiết 

kế đồ họa và áp file đồ họa đã thiết kế vào mẫu hộp theo đúng đường 

bleed đã tạo. 
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BÀI 7: TẠO THƯ VIỆN MẪU HỘP VỚI CÔNG 

CỤ STYLEMAKER 

Sau bài học này sinh viên có khả năng: 

- Hiểu được chức năng của các công cụ trong nhóm công cụ 

Stylemaker. 

- Hiểu được quy tắc, các loại biến số, lưu ý khi đặt biến số. 

- Tạo được file thiết kế cấu trúc có thông số kích thước thay đổi được. 

- Tạo được hình ảnh minh họa cho các biến số có trên mẫu hộp. 

- Tạo được các điều kiện ràng buộc cho các biến số. 

- Tạo được thư viện mẫu hộp cá nhân với các dạng hộp cơ bản, đặc 

biệt. 

 

Chức năng Stylemaker là chức năng cao nhất trong phần design 

của phần mềm ArtiosCAD. Nó cho phép người dùng vẽ lại các mẫu 

hộp có cấu trúc đặc biệt bằng các biến số, lưu file thiết kế vào thư viện 

mẫu để sử dụng lại. Khi được tạo, những bản thiết kế kèm thông số có 

thể được thêm vào Style Catalog và có thể được truy cập thông qua 

Run a Stadard hoặc thêm vào Geometry marcos catalog. 
 

1. TẠO FILE THIẾT KẾ CẤU TRÚC CHỨA 

BIẾN SỐ. 

Việc tạo file cấu trúc có chứa biến được thực hiện tương tự như 

khi vẽ lại một mẫu cấu trúc bất kỳ nào, chúng ta sẽ sử dụng các công 

cụ trong nhóm design để vẽ. Nhưng thay vì nhập giá trị số, chúng ta sẽ 

nhập ký hiệu tên biến – Variables. Bất kì phần nào trong thiết kế 

được thay đổi kích thước (resizeable), thì đều cần có một biến số hoặc 

một biểu thức gán vào nó. Để vẽ lại được file thiết kế, chúng ta cần 

một bản phát thảo các biến số, “công thức” thể hiện mối quan hệ giữa 

các cạnh, các đường trong mẫu thiết kế, điều kiện ràng buộc của các 

biến số. Suy nghĩ cách vẽ lại cấu trúc sao cho nhanh nhất, hợp lý nhất. 
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1.1 Tạo biến số cho mẫu thiết kế. 

Có ba cách để nhập vào thông tin của biến số: 

1. Vừa vẽ vừa tạo biến. Nhập tên của biến hoặc biểu thức biến 

trong thanh Trạng thái (Status bar) những dữ liệu khi vẽ. 

 

2. Mở Keypad bằng cách nhấn space bar hoặc click vào biểu 

tượng keypad . Keypad còn hiển thị bảng các biến đã 

được tạo, giúp dễ theo dõi và chọn biến số. 
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Nếu chúng ta sử dụng một trong những cách trên để tạo biến, thì mỗi 

biến mới được tạo sẽ xuất hiện lên một thông báo hỏi về việc tạo biến 

mới. Chọn Yes 

 

Nhập vào giá trị hiện thời (Current Value) cho tên biến (Variable 

Name). Mặc dù vẽ bằng biến số nhưng chúng ta cũng cần gán cho biến 

một giá trị tạm thời, giá trị này sẽ thay đổi được. Phần mô tả 

(description) giúp gợi nhớ ý nghĩa của biến được đặt. Click OK. 

 

3. Sử dụng hộp thoại StyleMaker. Chọn menu Design > StyleMaker. 

Click vào Add để nhập tên biến và giá trị hiện thời của biến số. 
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• Default Formula/Value là giá trị sẽ được tính toán khi sử dụng tính 

năng “Reinit” trong quá trình dựng lại (rebuild) hoặc chạy một chuẩn 

(Run a standard). 

 

• Nhập tên của biến số vào phần mô tả tên biến (Description). 

 

Giá trị được nhập vào phạm vi Current Value. Nó là giá trị 

được sử dụng khi thiết kế được vẽ lần đầu tiên sử dụng tên biến. 
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Cách 1, 2 là cách tạo biến trong quá trình vẽ, hay nói cách 

khác là vừa vẽ vừa tạo biến, cách thứ 3 là tạo hết các biến 1 lượt, sau 

đó mới dùng trong quá trình vẽ. 

Các biến tạo ra có thể xóa được, nhưng nếu đã dùng thì không 

thể xóa dù trên mẫu thiết kế không có đường nào có giá trị biến đó. 

 

1.2 Sử dụng các biến số trong quá trình vẽ. 

Cần xác định các công cụ vẽ cần được sử dụng để vẽ mẫu cấu 

trúc. Ví dụ, để vẽ cái hộp có thể sử dụng công cụ Line Angle/Offset 

hoặc công cụ Rectangle và công cụ Rectangle from a line. 

Khi sử dụng công cụ Line Angle/Offset tool cần phải nhập vào 2 giá 

trị: Góc (angle) và toạ độ X hoặc Y. Cả 2 giá trị này có thể được giữ 

cố định, một cố định một là biến số, hoặc cả 2 là biến số. 

 

Để xác định mức độ linh hoạt mà người dùng có thể có khi họ 

sử dụng bản thiết kế. Ví dụ khi vẽ nắp dán (Glue flap) với góc là 15 độ 

và toạ độ X là biến GF, người dùng có thể thay đổi chiều rộng của nắp 

dán nhưng góc luôn luôn được giữ là 15 độ. Họ chỉ có thể thay đổi giá 

trị là biến số xuất hiện ở trong menu. 

Trong quá trình vẽ, việc chọn điểm bắt đầu vẽ rất quan trọng, 

các nút neo phải chính xác mới hạn chế được sự biến dạng cấu trúc 

khi rebuild laij5 mẫu hộp. Chúng ta thường dùng công cụ Move to 

Point để chọn điểm bắt đầu mới. 
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Sau khi tạo file cấu trúc, chúng ta sẽ kiểm tra các đường bị 

trùng trong thiết kế bằng cách chọn Design>Design Checks để kiểm 

tra đường trùng lặp và lổ hổng. Lưu bản thiết kế hoàn chỉnh vào thư 

mục làm việc. 

Để kiểm tra việc thay đổi kích thước của mẫu thiết kế, chúng 

ta chọn Design > Rebuild Design hoặc nhấn phím F5 để kiểm tra bản 

thiết kế. Thay đổi các giá trị và kiểm tra thiết kế có thực hiện đúng hay 

không. Kiểm tra nhiều lần với nhiều giá trị khác nhau. 

Nếu sử dụng các biến số về độ dày giấy, thì thay đổi nhiều loại 

giấy có độ dày mỏng khác nhau để chắc chắn rằng các giá trị cho phép 

được sử dụng chính xác.  

1.3 Một số lưu ý khi tạo biến số và biểu thức 

Quy luật đặt tên cho các biến số: 
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ữ hoặc số (L1, W1, ...) 

ắt đầu bằng một chữ cái (L1 không phải 1L) 

ất là 6 kí tự 

ảng trắng giữa các kí tự 

Chọn một loại giấy sẽ tự động truy cập vào các biến số và giá trị hiện 

thời được thiết lập cho các loại giấy trong DataCenter (CAL, IL, OG 

và CRRV). 

Các biểu thức toán học tuân theo luật của thứ tự các phép toán. Ví dụ: 

Phép tính như 3+7*2 có giá trị là 17 khi quy luật thứ tự các phép toán 

được áp dụng vì phép nhân được ưu tiên hơn phép cộng. Ghi lại biểu 

thức này thành (3+7)*2 sẽ cho giá trị là 20 vì những phép toán trong 

ngoặc đơn được ưu tiên thực hiện trước. 

1. Ngoặc đơn (  ) 

2. Luỹ thừa N to the nth power 

3. Thứ tự từ trái sang phải những phép tính sau: Phép nhân 

X*N, Phép chia X/N,  

4. Thực hiện theo thứ tự từ trái sang phải những phép tính sau : 

Phép Cộng X+N, Phép trừ X-N 

 

2. TẠO HÌNH ẢNH MINH HỌA BIẾN SỐ 

(DIAGRAM) CHO FILE CẤU TRÚC 

Hình ảnh minh họa biến số - Diagram được tạo ra nhằm mục 

đích hướng dẫn cho người sử dụng biết vị trí của các biến để nhập giá 

trị cho chính xác. Chính vì vậy Diagram phải được dễ đọc, các minh 

họa biến số phải rõ ràng và tương ứng với từng nhóm biến có trong 

từng menu. 

Trước khi tạo diagram, chúng ta phải chia nhỏ mẫu cấu trúc 

từng bộ phận chức năng như: Thân hộp, nắp cài, đáy, tay dán, cài 

khóa....Mỗi một bộ phận sẽ chứa các biến số thuộc bộ phận đó, và sẽ 

có hình minh họa tương ứng cho các biến số đó. 
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Tạo 1 hình minh họa sẽ được thực hiện theo các bước sau: 

Bước 1: Chọn Design > StyleMaker. Chọn vào nút biểu đồ 

(Diagram) nằm ở phía dưới của cửa sổ. 

 

Ở cửa sổ tiếp theo, chọn tạo biểu đồ mới (Create New 

Diagram).  

 

 

Lúc này sẽ xuất hiện một hộp thoại như hình bên dưới. Hình 

này là toàn bộ hình ảnh cấu trúc hộp, chúng ta muốn tạo diagram cho 

phần nào thì “Click và kéo” chuột quét qua khu vực đó, động tác này 
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giống như chụp hình khu vực, hình ảnh của mỗi lần tạo sẽ nằm trong 

layer tên “DOC PLOT”. Đặt tên lại cho các doc plot theo tên của các 

bộ phận chức năng của hộp. 

Thực hiện tương tự bước 1 cho các bộ phận còn lại của cấu trúc hộp. 

Bước 2: Tạo các chú thích về biến trên diagram đã tạo. Sử 

dụng các công cụ tạo đương hiển thị kích thước Dimension.  

Nhấn vào nút Layers. Chuyển Doc Plot 1 thành Layer được kích hoạt 

(Active Layer) và tắt Main Design và Dimension layers: 

 

Chọn công cụ Dimension. Lúc này nó sẽ không thông báo cần 

tạo layer Dimension. Sử dụng công cụ kích thước (dimension tool) để 

đặt và kéo dài các kích thước. Click đúp chuột vào mỗi kích thước 

(hoặc click phải > chọn properties), đánh tên biến tương ứng vào ô 

“text” 

 

Thực hiện tương tự cho các biến còn lại thuộc doc plot đó.  
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  Bước 3: Tạo menu biến số tương ứng với từng bộ phận của 

hộp. Mở hộp thoại Sylemaker > chọn Advance > chọn ADD tại phần 

menu để tạo các menu biến > Đặt tên menu > chọn dạng menu > click 

OK. 

 

 

Sau khi tạo hết các menu, chúng ta sẽ di chuyển các biến số vào 

các menu phù hợp. Chọn biến số “Move” trong phần 

“Variables”,  hộp thoại Move to menu sẽ xuất hiện, chọn tên 
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menu muốn chuyển biến số vào đó > click OK để hoàn tất việc di 

chuyển biến. 

 

 

Lưu ý: Khi di chuyển các biến chúng ta phải quan tâm đến thứ tự của biến 

trong nhóm biến số. Biến số nào phụ thuộc thì phải nằm ở dưới hoặc thuộc 

menu phía dưới. Ví dụ biến A phải nhỏ hơn biến B, thì biến A phải nằm trên 

biến B, tức là phải có biến A rồi mới có biến B. Nên khi bố trí biến A phải 

nằm trước, được khai báo trước. Nếu thực hiện không đúng, phần mềm sẽ 

báo hộp thoại “Variable conflicts” 
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Bước 4: Bố trí các diagram phù hợp cho từng menu chứa biến. 

Sau khi tạo các diagram cho các menu, bước tiếp theo là chọn diagram 

tương ứng cho từng menu biến. Chọn tên menu > chọn tab Diagram > 

trong hộp thoại Attach Diagram to variable menu chọn hình 

diagram phù hợp với menu đó. Thực hiện tương tự cho các tab menu 

biến. 

 

 

3. TẠO ĐIỀU KIỆN RÀNG BUỘC CHO BIẾN 

SỐ. 

Đối với các biến số được nhập giá trị, chúng ta cần tạo các 

điều kiện ràng buộc để đảm bảo hình dạng của cấu trúc hộp không bị 

biến dạng. Giới hạn lại khoảng cho phép nhập của biến số đó và cảnh 

báo cho người dùng khi các giá trị được nhập vượt quá ngưỡng cho 

phép. 

Chọn design > stylemaker > chọn Advance > chọn biến số cần 

gán điều kiện > nhập biểu thức vào ô Check data.  
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Cùng là một điều kiện ràng nhưng nếu nhập vào ô Check 

condition sẽ được phép bỏ qua khi người dùng nhập quá giới hạn. Nếu 

nhập vào ô Enforced check thì không thể bỏ qua được. 

Những điều kiện ràng buộc nào bắt buộc phải thỏa, chúng ta sẽ 

nhập và ô Enforced check. Một số cách viết biểu thức điều kiện ràng 

buộc : 

 X4<=2.5 

 H<=C+6 

 R13<=N-R14 

 H7<=K5+2.5 AND H7>=K5 

 Y<=E/3 AND Y<=2.5 
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Giá trị hay biểu thức được nhập trong ô Formula sẽ đảm bảo 

tính tự động của mẫu cấu trúc. Người dùng có thể chỉ cần nhập các 

thông số cơ bản của hộp mà vẫn tạo được cấu trúc hộp. 

 

4. THÊM THIẾT KẾ VÀO THƯ VIỆN MẪU 

HỘP  STYLE CATALOG 

Sau khi tạo file thiết kế cấu trúc hoàn chỉnh, chúng ta lưu trữ vào ô dữ 

liệu. Để có thể sử dụng mẫu thiết kế từ chức năng Run a Standard, 

chúng ta sẽ tạo đường dẫn của file thiết kế trong Options > Defaults 

> Style Catalog 

Thiết kế sẽ có thể được chọn từ Run a Standard > Standards 

catalog sau khi nó được thêm vào Thư mục Style Catalog trong 

Options > Defaults. 

Click chuột phải vào thư mục Style catalog. Chọn New > Folder. Đặt 

tên cho thư mục. 

 

Click chuột phải vào folder vừa mới tạo và tạo New > Data, Đặt tên 

cho mẫu thiết kế. 
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Double click vào Data mới tạo > chọn ArtiosCAD > chọn đường dẫn 

đến vị trí lưu trữ của file bằng cách click vào Browse Button (…) để 

chọn file. 

 

 

Lưu ý: tên file thiết kế khi lưu sẽ được dùng làm tên file hiển thị 

trong phần workspace khi chọn mẫu hộp, vì vậy chúng ta tạo các 

mã số cho hộp để việc quản lý và tìm kiếm thuận lợi hơn. 

 

Chọn File > Save và click Yes để lưu các thay đổi. Chọn File > Exit. 



112 

 

5. SỬ DỤNG CHỨC NĂNG REBUILD 

PLAYBACK TRONG VIỆC THAY ĐỔI BIẾN 

SỐ. 

Chức năng Rebuild playback là một chức năng ghi chép lại tất cả 

các thao tác được thực hiện trong một file design. Chúng ta có thể sử 

dụng chức năng này để chỉnh sửa thông số của thiết kế hoặc thay đổi 

biến số bị gán sai. Hoặc có thể chuyển hóa file đã được vẽ bằng giá trị 

số thành giá trị biến. 

Chọn Design > Rebuild Playback. Click đúp và mũi tên bên trái 

cho việc dừng lại nhanh hơn (thanh cuộn sẽ di chuyển hết sang bên 

trái) để bắt đầu logfile. 

 

Click nút Edit trên thanh trạng thái. Hộp thoại Edit Log sẽ xuất hiện. 

 

Chọn mũi tên di chuyển bên trái hoặc bên phải để di chuyển đến bước 

thao tác cần chỉnh sửa thông tin. Ví dụ trong hình ở trên là cần chỉnh 

sửa thông số Y của đường thẳng thành biến số L thay vì là giá trị số.  

 

Nếu trong quá trình vẽ ta gán sai tên biến số thì có thể thực hiện tương 

tự để đổi lại biến số đúng cho đường. 
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6. MỘT SỐ LƯU Ý KHI TẠO MẪU CẤU TRÚC 

CÓ CHỨA BIẾN SỐ. 

1. Khi tạo các mẫu cấu trúc có nhiều panel thì cần lưu ý đến chiều 

di chuyển của copy để tạo tay dán cho phù hợp. 

 

2. Việc xây dựng sẽ thất bại nếu giá trị các panel ít hơn so với bản vẽ 

gốc, ví dụ như khi vẽ ta cho số lượng copy (p) là 5 mà khi rebuild lại 

chỉ có 3 thì phần mềm sẽ báo lỗi thiết kế. 
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3. Trong trường hợp giá trị của các Panel lớn hơn 5, việc xây dựng lại 

cũng không chính xác. 

 

Để vẽ chính xác một tay gài ở đây nên dùng công cụ Move By để định 

vị. 

 

4. Khi thiết kế và đưa vào các thông số chỉ để xác định khoảng cách 

sau đó xoá chúng đi, điều này đôi lúc gây ra thất bại trong quá trình 

rebuild. Do đó nên sử dụng công cụ Temporary Demension thay vì 

các công cụ vẽ kích thước thông thường khác. 

5. Thay đổi các đường line và hoàn chỉnh thiết kế trước khi sử dụng 

các công cụ copy. 

 

6. Xoá các đường conline trước khi sử dụng các công cụ copy. 
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Ở ví dụ bên dưới nếu sử dụng công cụ copy để copy nhiều lần và xoay 

các bản copy này trong khi các đường conline vẫn còn hiện diện trên 

nền bản vẽ, việc vẽ sẽ thất bại với các giá trị gần nhất mà vừa tạo (vd 

muốn tạo 4 mặt). Hộp thoại Rebuild failed sẽ xuất hiện. 

 

Xóa các đường conline trước khi copy thì việc vẽ sẽ chính xác hơn, 

Hộp thoại Rebuild failed sẽ không còn xuất hiện nữa. 

 

7.TẠO CHI TIẾT HÌNH HỌC THÔNG DỤNG 

THAY ĐỔI ĐƯỢC KÍCH THƯỚC 

Các chi tiết hình học thông dụng có kich thước thay đổi được 

để phù hợp với các thiết kế cấu trúc khác nhau. Chúng ta có thể tạo 

các dạng hình học này tương tự như tạo một file thiết kế thông thường, 

bao gồm các bước: tạo biến, điều kiện ràng buộc cho biến, vẽ hình, tạo 

diagram và lưu vào hệ thống Geometry macro. 
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Việc đưa mẫu hình học vào hệ thống Geometry macro được thực hiện 

như sau: Chọn Options > Defaults > Mở Geometry Macro Catalog > 

Nhấp chuột phải vào Geometry Macro Catalog > tạo thư mục mới 

(New folder) > đặt tên cho thư mục để dễ quản lý >Nhấp chuột phải 

vào thư mục mới tạo > chọn New Data. 

 

Nhấp đúp chuột vào tên data mới tạo. chọn đường dẫn cho data  tại ô 

File name. Trong Placement Option, chọn chế độ đặt hình học mặc 

định khi sử dụng hình học này, ví dụ như Place The Tool Centered on 

a Point. 
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Nhấp Apply sau đó OK để đóng hộp thoại. Chọn Save từ menu File 

trong hộp thoại mặc định. Chọn Yes để ghi đè lên. Chọn Exit. 

Ghi chú đặc biệt: biểu tượng macro mặc định có thể được thay thế 

bởi một biểu tượng do chính thiết kế. Đó là một ý tưởng hay nếu 

sử dụng Macros trên thanh công cụ. 

1. Tạo một file có đuôi là bmp16 pixels x 15 pixels để dùng cho 

Microsoft Paint hay 1 phần mềm biên tập icon.  

2. Để thay đổi icon vào Options> Defaults. 

3. Mở Geometry Macro Catalog và xác định Macro mà biểu tượng 

công cụ sẽ được thay đổi. 

4. Nhấp đúp vào icon hiện tại. Trong Geometry Bitmap Section, 

nhấp vào nút duyệt tìm. 

 

5. Chọn biểu tượng hình bitmap mới. 
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8. BÀI TẬP ỨNG DỤNG. 

Bài tập 1: Tạo file thiết kế cấu trúc theo biến số và các biểu thức như 

hình bên dưới, tạo diagram minh họa và lưu file thiết kế vào thư viện 

mẫu hộp. 

 

 

Bài tập 2: Tạo file đa giác có số cạnh thay đổi, chiều dài cạnh là biến 

a, số cạnh là n. 
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Bài tập 3: Tạo thân hộp đa giác đều có số cạnh và kích thước cạnh 

thay đổi được. 

 

Bài tập 4: Tạo file hình học với các biến như trong hình bên dưới, tạo 

diagram minh họa và lưu vào thư viện Geometry Macro.  

 

Bài tập 5: Tạo file chèn lót theo số lượng sản phẩm được bố trí theo 

chiều rộng và chiều dài, theo kích thước của sản phẩm 
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BẢNG PHÍM TẮT 

STT Chức năng Phím tắt STT Chức năng Phím tắt 

01 New Design Ctrl + N 17 Scale to Fit Ctrl + D 

02 Run a Standard Ctrl + 2 18 Zoom 

Rectangle 

Ctrl + R 

03 Convert to 3D Ctrl + 3 19 Zoom Out Ctrl + A 

04 New layout Ctrl + L 20 Close up 

Window 

Ctrl + Space 

05 Open Ctrl + O 21 Extend  Alt + X 

06 Save Ctrl + S 22 Clear Extend Ctrl + Alt + 

X 

07 Print Ctrl + P 23 Move to 

Point 

Ctrl + W 

08 Undo Ctrl + Z 24 Move by Ctrl + Q 

09 Redo Alt + Z 25 Line 

Angle/Offset 

Ctrl + 1 

10 Cut  Ctrl + X 26 Conline 

Offset/Angle 

Ctrl + F 

11 Copy  Ctrl + C 27 Keypad Ctrl + 4 

12 Paste  Ctrl + V 28 Rebuild F5 

13 Select  Ctrl + E 29 Measure Ctrl + G 

14 Move  Ctrl + M 30 Copy mode Ctrl + Insert 

15 Properties  Alt + 

Enter 

31 Move mode Ctrl + M  

16 Refresh  F2 32 Split line Ctrl + L 
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